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1 DXM Overview

1.1 DXM System Overview

Banner's DXM Logic Controller integrates Banner's wireless radio, cellular connectivity, and local 1/0 to provide a platform
for the Industrial Internet of Things (l110T).

( )
\ y

The DXM Controller's wired and wireless connectivity options make it easy to share data between local and remote
equipment. The cellular modem option eliminates the need for IT infrastructures to connect remote equipment for sensing
and control. The integrated Sure Cross® wireless radio enables Modbus connectivity to remote sensors, indicators, and
control equipment.

1
Z

The DXM Controller incorporates several automation protocols into its system, including:
= Modbus RTU—Integrates into existing RS-485 serial-based Modbus-enabled automation systems.
= Modbus TCP—Uses Ethernet to attach to existing Modbus-enabled automation systems.
= EtherNet/IP—Automation systems that use the EtherNet/IP protocol can directly attach to the DXM Controller using
Ethernet.

Internet messaging tools share information generated by sensors, indicators, and control equipment with automation
systems and personnel. When Internet messaging is used in combination with the logic controller, the DXM Controller can
generate and send historical data logs, alerts, and alarms using Ethernet or cellular connectivity options. Banner's API
interface allows the user to create connections with web-based automation or business systems.

Program the DXM Controller's logic controller using action rules and text language, which can execute concurrently. The
control functions allow freedom when creating custom sensing and control sequences. The logic controller supports the
Modbus protocol standards for data management, ensuring seamless integration with existing automation systems.
On-board universal and programmable 1/0 ports connect to local sensors, indicators, and control equipment.

A simple user interface consists of an LCD screen and four LED indicators. Use the LCD to access system status and

setup, view user selectable events or data, and to bind and perform site surveys for Sure Cross radios. Configure the user
programmable LEDs to indicate the status of the DXM Controller, processes, or equipment.

1.2 DXM Automation Protocols

The DXM Controller supports the following automation protocols.

www.bannerengineering.com - Tel: 763.544.3164 3
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Modbus RTU. The DXM Controller manages two separate physical ports running the Modbus RTU protocol. The DXM
Controller is the Modbus Master when operating the Modbus master RTU port. The DXM Controller uses the master Modbus
RTU bus to communicate with locally connected Modbus devices or uses the Banner wireless radio to communicate with
remote Modbus devices. The other Modbus RTU port is used by a host system to access the DXM Controller as a slave
device. The slave Modbus RTU port allows access all the internal registers concurrently with the master RTU port. By
default, the Modbus RTU ports are active. Configure the port parameters using the DXM Configuration Tool.

Modbus TCP/IP. A host system acting as a Modbus client can access the DXM Controller using the Modbus TCP/IP
protocol over Ethernet. Standard Modbus port 502 is used by the DXM Controller for all Modbus TCP/IP requests. All
internal registers are available to the host system concurrently with Modbus RTU. By default, Modbus TCP/IP is active.

EtherNet/IP™. The Ethernet port is actively running EtherNet/IP. From the factory the DXM Controller is configured to
read and write registers on DX80 wireless devices 1 through 16. Custom configurations can be set using the DXM
Configuration Tool. By default, EtherNet/IP is active.

1.3 DXM Modbus Overview

The DXM Controller uses internal 32-bit registers to store information. The processor's internal local registers serve as the
main global pool of registers and are used as the common data exchange mechanism. External Modbus device registers
can be read into the local registers or written from the local data registers.

The DXM Controller, as a Modbus master device or slave device, exchanges data using the local registers. Modbus over
Ethernet (Modbus/TCP) uses the local registers as the accessible register data.

Using Action, Read/Write, and Threshold Rules allows you to manipulate the processor's local registers. The ScriptBasic
programming capabilities extends the use of local registers with variables to create a flexible programming solution for
more complex applications.

The processor's local registers are divided into three different types: integer, floating point, and non-volatile. When using
local registers internally, the user can store 32-bit numbers. Using local registers with external Modbus devices follows the
Modbus standard of a 16-bit holding register. Local registers are accessible as Modbus ID 199.

Accessing the 1/0 Base and the LCD follows the same communication as an external Modbus device. Each device has an ID
number to uniquely identify itself. The 1/0 base is Modbus ID 200 and the LCD is Modbus ID 201.

DXM Controller

DXM Processor

ISM Radio (Modbus ID 1)

Local Registers
(Modbus ID 199) ay [ MultiHop |
Ethernet «———»

Local Registers Integer

RS-232/ICAN «——»
RS-485 (master) Local Registers Float
RS-485 (slave) Local Registers Non-Volatile |

usB

1/0 Base (Modbus ID 200)

1/0 Base ]

Display (Modbus ID 201)
Modbus Data » D Display |
Traffic Control

<—> Action Rules
<— Rd/Wr Rules
«—> Script Basic
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1.4 DXM Configuration Tool Overview

The main storage elements for the DXM Controller are its Local
Registers, which can store up to 4-byte values that result from
register mapping, action rules, or ScriptBasic commands.

The Register Mapping function has two main components: a read
rule and a write rule. These rules allow the user to program the ability
to read or write information from Modbus slaves to/from the local
registers.

The Action Rules allow for logic functions and manipulation of local
register data. Action rules are processed autonomously from other
local register functions. There are three types of action rules:
thresholds, register copy, and math/logic.

Use the Scheduler to program when values are sent to a local
register during a specific time, day, or week. Events can be
programmed by days of the week with the ability to create holidays
for exception conditions.

Use the Register View Utility to read or write local registers within
the DXM Controller or Modbus Slave devices connected to the DXM
Controller. This allows the user to debug connections to external
devices by viewing live local register data within the controller.

The System Settings define parameters for the DXM Controller,
including email notifications, Cloud settings, time of day settings, local
logging settings, SMS messaging, ScriptBasic programming control,
and Ethernet network settings.

DXM100 Controller Instruction Manual

DXM Configuration Software

Local Registers

Register Mapping
Action Rules
Scheduler
Script Basic

System Register
Settings View Utility

USB

XML Config File

| Ethernet N

The DXM Configuration Tool configures the DXM Controller by creating an XML file that is transferred to the DXM Controller
using a USB or Ethernet connection. The DXM Controller can also receive the XML configuration file from a Web server

using a cellular or Ethernet connection.

This configuration file governs all aspects of the DXM Controller operation. The wireless network devices are a separate
configurable system. Use the DX80 User Configuration Tool (UCT) to configure the internal DX80 wireless Gateway and the

attached wireless Nodes. Use the MultiHop Configuration Tool (MCT) if the internal radio is a MultiHop device.

All tools can be connected to the DXM Controller using a USB cable or an Ethernet connection. Each tool can be run

individually or launched through the DXM Configuration Tool.

www.bannerengineering.com - Tel: 763.544.3164
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2 DXM Hardware Configuration

2.1 DXM Hardware Configuration Overview

The DXM100 Controller can have multiple configurations. The DXM100 Controller will have a model number label on the
housing. Use the model number and model table above to identify which boards are included in the controller.

When opening the DXM100 Controller, follow proper ESD grounding procedures. Refer to the ESD warning in the appendix.

~«— Housing Catch

CellularAntenna o

Connection .
Cellular Radio Board

SAM4 Processor Board

ISM Radio
Antenna MultiHop or Gateway
Connection Radio Board

DXM100 I/0 Board

The DXM100 Controller 1/0 base board provides connections for all inputs, outputs and power. The base board also
contains a 12 V solar controller that accepts connections to a solar panel and SLA battery. The battery connection can also
be used with line power to provide a battery backup in case of line power outages.

The ISM radio, either a MultiHop or DX80 Gateway, fits on the base board in the parallel sockets. Install the ISM radio so
the U.FL antenna connection is to the side with the SMA antenna connectors. Connect the U.FL cable from the ISM radio
U.FL to the right side U.FL connector. The ISM radio boards are available with either a 900 MHz radio or a 2.4 GHz radio.

The SAM4 processor board plugs into the base board using the two 20 pin socket connectors. The board sits above the ISM
radio socket and held by the base board standoffs. Position the processor board so the USB and RJ45 Ethernet connection
is to the front, away from the SMA antenna connections.

The top plugin PCB is the optional cellular radio. This plugs into the SAM4 processor board with the U.FL antenna
connection to the left. Attach the antenna cable from the cellular module to the left U.FL connection on the base board.

The top housing contains the LCD display board. The display board is connected to the base board using a ribbon cable
with a 20 pin connector.

In some DXM models, the cellular radio module may be replaced with an ISM radio. The top ISM radio antenna connection
will be to the left SMA connector.

6 www.bannerengineering.com - Tel: 763.544.3164
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2.2 ISM Radio Board (Modbus Slave ID 1)

The ISM radio board may be a MultiHop radio (DX80DR*M-HES5) or a Performance Gateway radio (DX80G*M2S-PE5). Refer
to the model number label on the DXM100 Controller and the model number table to identify the ISM radio type.

The ISM radio should be plugged into the 1/0 base board

with the U.FL antenna connector closest to the SMA
connectors.

A - Antenna connector

B

=

B - Button

C - LED

D1 - DIP switches
D2 - DIP Switches

D1

[

HEHE

2.2 MultiHop (HE5) DIP Switch Settings

D1 Switches D2 Switches

Device Settings

1 2 3 4 1 2 3 4

slots

Serial line baud rate 38400 OR 32 receiver slots
Serial line baud rate 9600 OR 128 receiver slots
Serial line baud rate Custom OR 4 receiver slots
Parity: None

Parity: Even

Parity: Odd

Disable serial (low power mode) and enable the
receiver slots select for switches 1-2

Transmit power
900 MHz radios: 1.00 Watt (30 dBm)
frame

Transmit power
900 MHz radios: 0.25 Watts (24 dBm)
frame

Application mode: Modbus

Application mode: Transparent

Serial line baud rate 19200 OR User defined receiver OFF* OFF*

2.4 GHz radios: 0.065 Watts (18 dBm) and 60 ms

2.4 GHz radios: 0.065 Watts (18 dBm) and 40 ms

OFF ON

ON OFF

ON ON

OFF~ OFF~*

OFF ON

ON OFF

ON ON

OFF*

ON

OFF*

ON

www.bannerengineering.com - Tel: 763.544.3164 7
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D1 Switches D2 Switches
Device Settings 2 3 2 3 4
MultiHop radio setting: Repeater OFF OFF
MultiHop radio setting: Master OFF * ON *
MultiHop radio setting: Slave ON OFF
MultiHop radio setting: Reserved ON ON
* Default configuration
2.2 Performance Gateway (PE5) DIP Switch Settings
Switches
Device Settings 1 2

Transmit Power Level: 1 Watt (30 dBm) OFF (default)

Transmit Power Level: 250 mW (24 dBm), DX80 Compatibility Mode ON

2.2 Button Operation

Typically you use the DXM LCD to put the device into binding mode, but you may also use the button on the ISM radio
boards to enter binding mode. However, most DXM models will not provide access to this button.

2.2 LED Operation

The LED located on the ISM radio module indicates power and communications traffic.
= Solid green DX80 ISM radio LED: Indicates power.
* Flashing green MultiHop ISM radio LED indicates operation.
« Red and green combined: Communications traffic and binding.

2.3 SAM4 Processor Board

A - Cellular radio connection

B - Force cloud push/Clear password
C - Boot load jumpers

D - DIP switches

E - Micro SD card

O O Al
LEDﬂ:ll Uj
0 N =HH=
LED‘EZLi%| E : E K
|

a o
LED3 Il

]
[ ot
e 1 E s

OBM Cﬂ ﬂo

Cellular Radio Connection. Install the cellular modem onto the SAM4 board with the cellular modem's U.FL connector on
the left. The antenna cable will go between the cellular U.FL connector and the left 1/0 board U.FL connector. Only install/
remove a cellular modem when the power to the device is disconnected.

nnnnnnonon
TTOTTTTOTT

>
.|
O

NO0N00Nan

Tooooooo

Force Cloud Push button. Press and hold this button for two seconds to send an immediate push message from the
device (if properly configured).
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Clear Password. By default, the DXM Controller does not require a password to load a configuration file. If a password is
defined, the DXM Controller requires that you enter the password before uploading a configuration file. To change the
password, you must already know the current password. If you do not know the current password, clear the password
from the DXM Controller.

& CAUTION: Clearing the password erases the current configuration and any program files, log files, or
history files currently on the DXM Controller.

Follow these steps to clear the password requirement from your DXM Controller.

1. Turn off the power.

2. Set DIP switch 4 to the ON position.

3. Press and hold button 'B'.

4. Apply power to the device.

5. After leaving the device powered on for a few seconds, turn off the power again.
6. Set DIP switch 4 to the OFF position.

7. Reload the configuration file before resuming normal operation.

The password is cleared from the system.

2.3 DIP Switch Configuration

Cycle power to the device after making any changes to the DIP switch settings.

DIP Switches

Settings

1 2 3 4

OFF *
Disable Ethernet Port
ON
OFF *
Disable LCD Display
ON
Not used OFF *
OFF *
Bypass XML
ON
Bypass XML

Turn to ON to have the XML file ignored at boot time. This is useful for ignoring a corrupt or questionable XML
configuration file. After the device is running, a new XML file can be loaded using the DXM configuration tool. The
factory default position is OFF.

Disable Ethernet Port
Set to ON to power down the Ethernet interface. The factory default position is OFF.

Disable LCD Display
Set to ON to disable the LCD. This DIP switched should be ON when the LCD display board is not connected. The
factory default position is OFF.

2.3 Button Operation

The SAM4 processor button has two functions:
« Clearing the access password as explained above.

= Pressing the button for 5 seconds forces a Push to the webserver. This assumes a proper configuration for the
webserver.

2.3 LED Operation

By default, the four LEDs indicate the following conditions:
= LED 1 - Heartbeat, indicates the processor is running.

= LED 2 - Indicates the cellular modem power cutoff is active. If the incoming power is less than 11.2 V, the cellular
modem is powered down.

= LED 3 - XML configuration file was rejected.
e LED 4 - ScriptBasic program failed to load.

www.bannerengineering.com - Tel: 763.544.3164 9
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2.4 1/0 Base Board

AOUT2
AOUT1
v

L= g =

O O

(]

1 18

For the complete 1/0 base board definitions, see 1/0 Base Board Connections on page 13.

A Base board LED E Jumpers - Configures Analog Out 1 J Modbus Slave ID DIP Switches
and 2 for mA or V

B Al. Cellular antenna F Radio Binding Button K Modbus Slave ID DIP Switches

C Radio LED G Programming header L SAM4 Processor Board Connection

D A2. ISM Antenna H ISM Radio Board Connection M Display Connection

2.4.1 DIP Switches for the 1/0 Board

The DXM100 Controller 1/0 board DIP switches are set from the factory to Modbus Slave ID 200 and should not need to be

changed. For more advanced information about the DIP switches, refer to Setting the Modbus Slave ID on the 1/0 Base
Board on page 11.

2.4.2 1/0 Board Jumpers

Hardware jumpers on the DXM 1/0 board allow the user to select alternative pin operations. Turn the power off to the
device before changing jumper positions.

Jumper Function Positions

E Analog output characteristics for Defines current (0—20 mA) or voltage (0—10 V) for analog output 1 and 2.
AO2 (pin 19) and AO1 (pin 20)

By default, current (0—20 mA) is selected using jumpers 1 and 2 and registers 4008 and 4028
contain a value of 2.

To select voltage (0—10 V) for output Aoutl, set jumper 1 in the voltage position (V) and set
Modbus register 4008 on the 1/0 board (SID 200) to 3.

To select voltage (0—10 V) for output Aout2, set jumper 2 in the voltage position (V) and set
Modbus register 4028 on the 1/0 board (SID 200) to 3.

10 www.bannerengineering.com - Tel: 763.544.3164
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2.4.3 Setting the Modbus Slave ID on the 1/0 Base Board

Only DXM Slave models require that the Modbus Slave ID to be adjusted on the 1/0 base board. The DXM100 Controller
models use DIP switches J and K to set the Modbus Slave ID. This device can use a Modbus register 6804 in the 1/0 board
to access the full range of Modbus Slave IDs.

On the DXM100 Controller models, use the DIP switches at location K to define the lower digit of the Modbus Slave ID.

2.4.3 DXM100 Controller Models

DIP Switch location J defines the course group of Modbus Slave IDs. DIP Switch 4 must be set to ON for DXM100-S1 and
DXM100-S1R2 models.

Location J DIP Switches
Settings
1 2 3 4
Modbus Slave ID set to 11 through 19 OFF OFF
Modbus Slave ID set to 20 through 29 ON OFF
Modbus Slave ID set to 30 through 39 OFF ON
Modbus Slave ID set to 40 through 49 ON ON
Not Used -
Modbus Slave Configuration (S1 model only) 1 ON
Standard Communication Mode OFF
DIP Switches J DIP Switch K, Switches 1, 2, 3, 4 (0 is OFF, 1 is ON)
1 2 0,0,0,0 1,0,0,0 0,1,0,0 1,1,0,0 0,0,1,0 1,0,1,0 0,1,1,0 1,1,1,0 0,0,0,1 1,0,0,1
OFF OFF x2 11 12 13 14 15 16 17 18 19
ON OFF 20 21 22 23 24 25 26 27 28 29
OFF ON 30 31 32 33 34 35 36 37 38 39
ON ON 40 41 42 43 44 45 46 47 48 49

DXM100 Controller Example
To set the DXM100 Controller to a Modbus Slave ID of 34, set the following:

Location J DIP switches set to 1=0FF, 2=0N
Location K DIP switches set to 1=0FF, 2=0FF, 3=0N, 4=0FF

The location J DIP switches set the upper Modbus Slave ID digit to 3 while the location K DIP switches set the lower digit to
4.

2.4.3 Setting the DXM 1/0 Board Modbus Slave 1D using Modbus Registers

Write to the 1/0 board's Modbus register 6804 to set the Modbus Slave ID to any valid Modbus Slave ID (1 through 245).

= For the DXM100 Controller model, all switches on DIP switch K should be in the OFF position to use the Modbus
register slave ID.

1 Must be in the ON position for the -S1 model)
2 yses value in Modbus register 6804.

www.bannerengineering.com - Tel: 763.544.3164 11
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2.5 Cellular Modem Board

>[(©))

=
o o000

o df]o
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2.6 DXM100 Dimensions

The optional cellular modem is installed on the SAM4 processor
board on the two 12-pin sockets. The U.FL connector should be to
the left, with the antenna cable going to the left antenna U.FL
connector.

594

45

B |

000 | I

Hininininin aininininn e
4‘

'7

st 105

All measurements are listed in millimeters, unless noted otherwise.
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3 DXM Connections

3.1 1/0 Base Board Connections

AOUT2
AOUT1
\

DXM100 Controller Instruction Manual

J

K

c

1 18
1 No connection 12 CT. RS-232 CTS 23 N3. NMOS OUT 3
2 PW. 12 to 30 V dc or solar power in (+) 13 S-. Secondary RS-485 — 24 N2. NMOS OUT 2
3 GD. Ground 14 S+. Secondary RS-485 + 25 N1. NMOS OUT 1
4 B+. Battery in (< 15 V dc) 15 CL. CANL 26 GD. Ground
5 GD. Ground 16 CH. CANH 27 U4. Universal Input 4
6 M-. Primary RS-485 — 17 GD. GND 28 U3. Universal Input 3
7 M+. Primary RS-485 + 18 P3. Courtesy Power 5 V 29 GD. Ground
8 GD. Ground 19 A2. Analog OUT 2 30 zé.\gdjustable Courtesy Power (5 V or
9 TX. RS-232 Tx 20 Al. Analog OUT 1 31 U2. Universal Input 2
10 | RX. RS-232 Rx 21 | P2 Adjustable Courtesy Power (5 V 32 | UL. Universal Input 1
or 16 V)
11 RT. RS-232 RTS 22 N4. NMOS OUT 4
A | Base board LED g | Jumpers - Configures Analog Out 1 3 Modbus Slave ID DIP Switches
and 2 for mA or V

B Al. Cellular antenna F Radio Binding Button K Modbus Slave ID DIP Switches
C Radio LED G Programming header L SAM4 Processor Board Connection
D A2. ISM Antenna H ISM Radio Board Connection M Display Connection

3.2 Applying Power to the DXM100 Controller

Apply power to the DXM100 Controller using either 12 to 30 V dc or a 12 V dc solar panel and 12 V sealed lead acid
battery operating together.

www.bannerengineering.com - Tel: 763.544.3164
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The DXM100 has three power input and three power output options:
= Input Power:
° 12 to 30Vdc
o 12 to 30 V dc solar panel
o 12 V dc sealed lead acid battery with automatic charging

= Courtesy Output Power Supplies:
> One 5V dc fixed
° Two 5V dcor16Vdc

The DXM Controller continuously monitors the health of the power inputs. If a power input fault is detected, the DXM
Controller automatically switches over to battery with continuous uninterrupted operation.

If the incoming voltage drops below 11.2 V, the cellular modem does not turn on and will not turn on until the voltage is
above 11.8 V. A text file (CmVMon.txt) on the internal micro SD card saves the periodic sampling of the incoming voltage.
If cellular operation stops because of voltage, it is logged in this file.

The DXM Controller automatically charges the sealed acid battery. The charging algorithm is designed to work with a
sealed lead acid (SLA) battery only.
= When using 12 to 30 V dc , connect the 12 to 30 V dc + to pin 2 and connect the ground to pin 3.
= When using main dc power with a back up battery (default configuration), connect the incoming main power pin 2
(+) and to pin 3 (-). Connect the 12 V sealed lead acid battery to pin 4 (+) and pin 5 (-). The incoming main power
must be 15 to 30 V dc to charge the battery.
= When using a solar panel, connect the solar panel output to pin 2 and connect the ground to pin 3. Connect the 12
V dc SLA battery to pin 4 (+) and pin 5 (-). To change the charging algorithm, refer to Supplying Power from Solar

(B1 and S1).
Pin Description
Pin 1 No connection
Pin 2 12 to 30 V dc input (+) or solar panel connection (+)
Pins 3, 5, 8, 17, 26, 29 Main logic ground for the DXM100 Controller
Pin 4 Solar or backup battery positive input. Battery voltage must be less than 15 V dc. Use only a sealed lead acid (SLA)

battery.

3.2 Using Courtesy Power or Switch Power
Pin 18 of the DXM100 Controller is a constant power source that supplies 5 volts up to 500 mA.

Pins 21 (switch power 2) and 30 (switch power 1) are switched power outputs. Configure the switched power outputs using
Modbus registers. The output voltage can be either 5 volts or 16 volts and is controlled using a Modbus register on the 1/0
board (Modbus slave ID 200).

Turn the switched power on or off using the output register 505 for switch power 1 or 506 for switch power 2. For
continuous power, set the Default Output register to 1, then cycle the power.

Switch Power Enable Register Voltage Register Default Output Register Output Register
1 (pin 30) 2201 3601 3602 505
Write a O to turn OFF Write a O to select 5 V (default)
Write a 1 to turn ON (default) Write a 1 to select 16 V
2 (pin 21) 2251 3621 3622 506
Write a O to turn OFF Write a O to select 5 V (default)
Write a 1 to turn ON (default) Write a 1 to select 16 V

Enable Register Configuration registers that turn on the ability to use the switched power output.
Default setting = ON

Voltage Register Configuration registers that define the output voltage (5 or 16 V) to the switched power output.
Default setting =5V

Default Output Configuration registers that turn on the switched power outputs for continuous power out.
Register Set register to 1 for continuous power. Cycle power if this register is changed.

14 www.bannerengineering.com - Tel: 763.544.3164
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Default setting = 0

Modbus Output Turn on or turn off the voltage output. If both outputs 505 and 506 are turned on at the same time
Register but are set to different voltages, the output voltage is 5 V.

3.2.1 Supplying Power from 12 to 30 V dc and a Battery Backup

The factory default setting for the battery charging algorithm assumes you are using 12 to 30 V dc to recharge the battery.

Modbus Slave 1D Modbus Register Description

200 * 6071 Battery backup charging algorithm.

0 = Battery is recharged from a solar panel
1 = Battery is recharged from 12 to 30 V dc . (default)

* The Modbus Slave ID for the base board is set at the factory. This may be changed using the base board DIP switch
settings.

3.2.2 Supplying Power from a Solar Panel

To power the DXM100 Controller from a 12 V dc solar panel, connect the solar panel to power pins 2(+) and 3(-). Connect
a 12 V dc sealed lead acid (SLA) rechargeable battery to pins 4(+) and 5(-).

The factory default setting for the battery charging algorithm assumes you are using 12 to 30 V dc power to recharge the
battery. If the incoming power is from a solar panel, you must change the charging algorithm.
To change the charging algorithm from the menu system:

1. From the LCD menu, select Update > Power.
2. Use the up/down arrows to select "SOLAR" power.

To change the charging algorithm by writing to Modbus register 6071 on the 1/0 base board (Slave ID 200):
1. Write a O to select the solar power charging algorithm.

Modbus Slave 1D Modbus Register Description

200 * 6071 Battery backup charging algorithm.

0 = Battery is recharged from a solar panel
1 = Battery is recharged from 12 to 30 V dc . (default)

The following power operating characteristics are stored in Modbus registers.

Battery voltage If no battery is present, the value in this register is less than 5 V. If the value in this register is
greater than the incoming voltage register, the battery is powering the system.

Battery charging The charging algorithm charges the battery when the incoming voltage register value is greater

current than the battery voltage register value. This registers shows the charging current in milliamps.

Incoming supply The incoming power can be from a solar panel or from a power supply. The battery is charging

voltage when the incoming voltage register value is greater than the battery voltage register value. The

battery is powering the system when the incoming voltage register value is less than the battery
voltage register value.

On-board This register stores the on-board thermistor reading in tenths of degrees C, this is not a calibrated
thermistor input: divide by 10 to calculate the temperature in degrees C. For calibrated temperature inputs,
temperature define one of the universal inputs as a temperature input.
Modbus Slave ID  Modbus Register Description
200 * 6081 Battery voltage (mV)
6082 Battery charging current (mA)
6083 Incoming supply voltage (mV) (solar or power supply)
6084 On-board thermistor temperature (°C)

* The Slave ID for the base board is set at the factory. This may be changed using the base board DIP switch settings.
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3.3 Connecting the Communication Pins

The base board communications connections to the device are RS-485 (primary), RS-485 (secondary) or RS-232.

RS-485. The primary RS-485 bus is a common bus shared with the ISM radio board (Modbus Slave ID 1) or optional
cellular board. The DXM100 Controller is defined as the Modbus Master on this bus. Other internal Modbus slaves include
the local processor registers (Modbus Slave ID 199), the base 1/0 controller (Modbus Slave ID 200), and the display board
(Modbus Slave ID 201). When assigning Modbus Slave IDs to externally connected devices, only use IDs 2 through 198.

RS-232. The RS-232 bus is not currently defined.

Pin Parameter Description

Pin 6 Primary RS-485 — Running Modbus protocol at 19.2k baud, use this bus to connect to other Modbus

Pin 7 Primary RS-485 + Slave devices. The DXM100 Controller is a Modbus Master device on this RS-485 port.
Pin 9 RS-232 Tx Serial RS-232 connection. This bus must use a ground connection between devices to
Pin 10 RS-232 Rx operate correctly.

Pin 13 Secondary RS-485 — The DXM100 Controller is a Modbus slave on this bus (see 1/0 Base Board Connections
on page 13).

Pin 14 Secondary RS-485 +

Pin 15 CANL —

Pin 16 CANH +

3.3 Modbus RTU Master/Modbus RTU Slave

The DXM100 Controller can be a Modbus RTU master device to other slave devices and can be a Modbus slave device to
another Modbus RTU master. The DXM100 Controller uses the primary RS-485 port (pins 6 and 7) as a Modbus RTU
master to control external slave devices. The secondary port (pins 11 and 12) is the Modbus RTU slave connection.
= As a Modbus RTU master device, the DXM100 Controller controls external slaves connected to the primary RS-485
port, the local ISM radio, local 1/0 base board, and the local display board.
= As a Modbus RTU slave device, the DXM100 Controller local registers can be read from or written to by another
Modbus RTU master device.

Use the DXM Configuration Tool to define operational settings for both the Modbus RTU master port and the Modbus RTU
slave port.

3.4 Ethernet

Before applying power to the DXM100 Controller, verify the Ethernet cable is connected. If the Ethernet cable is not
connected when the device powers up, the DXM100 Controller will not recognize the connection.

The Ethernet connection supports the DXM Configuration Tool, Modbus/TCP, and EtherNet/IP. ScriptBasic also has access
to Ethernet for custom programming. Use the DXM Configuration Tool to configure the characteristics of the Ethernet
connection, fixed IP addresses, DHCP, etc. The LCD menu allows the user to change the IP Address.

3.5 Modbus Master Port and Slave Port
There are two RS-485 ports on the DXM Controller, a Modbus master RS-485 port and a Modbus slave RS-485 port.

The Modbus master RS-485 is controlled by the DXM Controller, which acts as the Modbus master. All wired devices
connected to the master RS-485 port must be slave devices.

The Modbus slave RS-485 port is controlled by another Modbus master device, not the DXM Controller. The slave port is
used by other devices that want to access the DXM Controller as a Modbus slave device. All local registers are available to
be read or written from this slave port. Set the Modbus Slave ID for the secondary RS-485 port using the LCD display
menu: System > DXM Slave ID.
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3.5.1 Modbus Master and Slave Port Settings

The basic communications parameters for the RS-485 ports are set in the DXM Configuration Tool and are saved in the
XML configuration file. All basic settings are available under Settings > General screen of the DXM Configuration Tool.

Master port parameters include:
= Baud rate and parity
= Set the Communications Timeout parameter to cover the expected time for messages to be sent throughout the
wireless network. For the DXM Controller, the Communications Timeout parameter is the maximum amount of
time the DXM Controller should wait after a request is sent until the response message is received from the Modbus
slave device.

= Maximum Polling Rate sets the minimum wait time from the end of a Modbus transaction to the beginning of the
next Modbus transaction.

(eEW el Cloud Services || Logging | Scnpting | Metwork | Mail and Messaging | Administration

Local Registers

Device Time
Register Mapping Current Device Time:  -——— | Get Time From Device | | Synch PC Time with Device |
Device Timezone (UTC): | Ceniral Standard Time (UTC-05:00) Cenfral Time il] - |
Action Rules Device Observes DST: []
Device Location/GPS Modbus Master Communications Modbus Slave Communications
Scheduler Default Latitude: 0 Serial Mode: RS-485 - Serial Mode:  |[RS-485 |~
Default Longitude: 0 Baud Rate: 19200 - Baud Rate: 19200 -
Register View Acquire Using: Default Lat/Lor| ~ eI (None  j =) | | Party: (None |~
" Communication Timeout: 500 % Wireless Modbus Backbone: []
External GPS Address: o,
Maximum Polling Rate: m0 3
Settings Acquire GPS data every: 00:00:00 7 Enable DX80 Polling (43 buffer): 0
Send location to cloud: O

The Modbus Slave port settings include:
= Baud rate and parity (also set on this screen)
= Set the Modbus Slave port ID using the DXM Controller LCD
= Set the Wireless Modbus Backbone parameter when there is an ISM radio plugged into the SAM4 processor

board and the Modbus slave port is using the MultiHop radio as the slave port instead of the terminal block
connection.

3.5.2 Modbus Slave Port ID

Set the DXM Modbus slave port using the LCD menu system. On the LCD,

use Fhe down arrow to highlight System. Enter the System menu by Banner En g
clicking Enter. —9——.
0 - Registers R
>Push S ->082515 il
- ISM Radio
- System
Q - System Info @

To change the DXM Slave ID, highlight DXM Slave ID, then click Enter.

082545

\ rato s
o R

restatis needed

.

[T ——
<Ent> Accept ID
Soco Provestien

M Raio 082545
1SM Type: MuliFop
1SM Modous D: 1
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Use the up and down arrow buttons to change the DXM Slave ID.

Press Enter to accept the ID change.

After you change the DXM Slave ID, use the DXM Configuration Tool to cycle power to the device. After cycling power to
the device, the updated DXM Slave ID is listed under the System menu.

3.6 USB

The USB port is used with the DXM Configuration Tool to program the DXM100 Controller. The USB port is also used as the
console output for the processor and ScriptBasic.
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4 Working with Modbus Devices

4.1 Overview
The DXM Controller has two physical RS-485 connections using Modbus RTU protocol.

The master Modbus RS-485 port is for the DXM Controller to act as a Modbus master device to control internal and
external Modbus slave devices.

The Modbus master RS-485 port is labeled M+, M- on the DXM Controller. The Modbus slave port is used when another
Modbus master device wants to communicate with the DXM Controller when the DXM Controller is a Modbus slave device.

The Modbus slave RS-485 port is labeled S=, S1 on the DXM Controller.

Ethernet
Processor Modbus

Control/Data

Modbus RS-485 €————p

(slave port) Modbus RS-485

(master port)

N

I I I I External
- Modbus
Local GW/MH Display 1/0 Base Slaves (2-10)
Registers Radio
Modbus Modbus Modbus Modbus
SID 199 SID 1 SID 201 SID 200

The DXM Controller has dual Modbus roles: a Modbus slave device and a Modbus master device. These run as separate
processes.

The Modbus slave port allows access into the DXM Controller local registers. To operate as a Modbus slave device, the DXM
Controller needs to be assigned a unique Modbus slave ID as it pertains to the host Modbus network. This slave ID is
separate from the internal Modbus slave IDs the DXM Controller uses for its own Modbus network. The DXM Modbus slave
ID is defined through the LCD menu. Other Modbus slave port parameters are defined by using the DXM Configuration
Tool.

The DXM Controller operates the Modbus master port. Each device on the master port must be assigned a unique slave ID.
There are slave IDs that are reserved for internal devices in the DXM Controller.

DXM Internal Modbus Slave IDs (factory default)

Modbus Slave ID Device
1 Gateway (PE5) or MultiHop (HE5) ISM Radio—MultiHop wireless devices connected to the internal MultiHop radio should
be assigned Modbus Slave addresses starting at 11.
199 Local Registers—Internal storage registers of the DXM Controller
200 1/0 Base Board—All data and parameters for each input or output of the DXM Controller.
201 LCD Display—The user has access to the LED indicators on the DXM Controller.

4.2 Assigning Modbus Slave IDs

4.2 DXM Modbus Slave ID

Assign the DXM Modbus Slave ID only if a Modbus master device is reading or writing the DXM Controller Local Register
data through the Modbus RS-485 slave port (S+, S-).

Set the DXM Slave ID from the LCD menu under System > DXM Slave ID. The DXM Controller can have any unique slave

ID between 1 and 246, depending upon the host Modbus network. Other RS-485 slave port parameters are set in the DXM
Configuration Tool under the Settings > General tab.
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4.2 DXM Master Configuration

The DXM Controller operates as a Modbus master device, use the DXM Configuration Tool to configure read or write
operations of the DXM Modbus network. The DXM Controller communicates with all internal and external peripheral devices
using the external Modbus bus RS-485 (M+, M-)

There are four internal Modbus slave devices that are configured from the factory with slave IDs. Assign slave IDs of 2
through 10 to Modbus slave devices that are physically wired to the DXM Controller. Assign slave IDs or 11 through 60 to
wireless slaves within the MultiHop network.

Do not assign a slave ID of greater than 10 to Modbus slave devices that are physically wired using the RS-485 port if
there is an internal MultiHop ISM radio in the DXM Controller. The MultiHop ISM radio attempts to send any Modbus data
intended for slaves 11-60 across the radio network, which conflicts with wired slave devices if the slave IDs overlap. The
MultiHop master radio can be changed from the factory default of 11-60 Modbus slave IDs if more hardwired slaves are
required.

4.3 Modbus Operation

All Modbus transactions are managed by a central Modbus engine. If there are Modbus messages intended for a Modbus
slave that doesn't exist, the Modbus engine waits for a response until the timeout period is expired. This slows down the
Modbus polling loop for read and write operations. For this reason, verify all Modbus read and write operations are
intended for Modbus slave devices that are in the network.

If a Modbus slave is not in the network, either a wired or wireless device, the operation of the LCD menu system can be
compromised. Operations like Binding, Site Survey, or accessing the ISM menu may be slower. This is because all internal
devices of the DXM Controller are also Modbus slaves, ISM radio, 1/0 base board, LCD, and internal Local registers.

4.4 Wireless and Wired Devices

4.4 Wireless DX80 Gateway

The DX80 Gateway architecture is a star architecture in which all Nodes in the system send their data back to the
Gateway. The host can access the entire network data from the Gateway, which is Modbus slave ID 1.

Because the DXM Controller will not be sending any Modbus messages across the wireless link, the timeout parameter can
be set low (less than 1 second) and it is treated like a directly connected device.

4.4 MultiHop Master

The MultiHop master radio forms a wireless tree network using repeaters and slave devices. Each device in a MultiHop
network must be assigned a unique Modbus Slave ID and is accessed as a separate device.

For the DXM Controller to talk with a MultiHop device in the wireless network, the master MultiHop device interrogates
every message on the RS-485 bus. If they are within the wireless devices range (slave IDs 11 though 60), the message is
sent across the wireless network. To change this range, the user must adjust the offset and range setting in the MultiHop
master radio (Modbus Slave ID 1). Modbus register 6502 holds the Modbus offset, default 11. Modbus register 6503 holds
the number of Modbus slaves allowed (maximum of 100).

Modbus Slave 1D Description

1 Allocated for the internal ISM radio device, either a DX80 Gateway or MultiHop Master
2-10 Slave addresses available for direct connected Modbus slave devices to the master RS485 port (M+ , M-)
11-60 Allocated for wireless MultiHop radio network devices. If there is not an internal MultiHop in the DXM Controller, these slave

addresses are available to use for directly connected devices.

61-198 Available to user for direct connected Modbus slave devices or the expansion of the wireless network slave IDs to go past 50
wireless devices.

199 Allocated for internal Local Register
200 Allocated for the 1/0 base board, will be different for special DXM slave only models.
201 Allocated for the LCD display board, the user can read/write LEDs.
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4.5 Modbus Timeouts

A Modbus timeout is the amount of time a Modbus slave is given to return an acknowledgement of a message sent by the
Modbus master. If the Modbus master waits for the timeout period and no response is seen, the Modbus master considers
it a lost message and continues on to the next operation.

The timeout parameter is simple to set for Modbus devices directly connected to the DXM controller, if there are no
MultiHop wireless devices. If a MultiHop network a part of the DXM Controller, special considerations need to be made to
set the timeout parameter.

Wireless communications are inherently lossy networks, and controllers operating these networks must be configured to
allow for enough time for hardware transmission retries. Set the Communications Timeout parameter to cover the
expected time for messages to be sent throughout the wireless network. For the DXM Controller, the Communications
Timeout parameter is the maximum amount of time the DXM Controller should wait after a request is sent until the
response message is received from the Modbus slave device. Use the DXM Configuration Tool to set the timeout parameter
on the Settings > General screen.

The default setting for the timeout parameter is 5 seconds.

4.5 MultiHop Networks vs DX80 Star Networks

The MultiHop wireless architecture is much different from the DX80 star architecture. Although both are wireless networks,
the DX80 star Gateway collects all the data from the Nodes, which allows the host system to directly read the data from
the Gateway without sending messages across the wireless network. This allows for DX80 Gateway to be treated like any
other wired Modbus device.

In a MultiHop network, the data resides at each device, forcing the controller to send messages across the wireless
network to access the data. For this reason, carefully consider the value of the wireless timeout parameter.

4.5 Battery-Powered MultiHop Radios

Battery-powered MultiHop radios are configured to run efficiently to maximize battery life. In optimizing battery life, the
allowed communications window for receive messages is slow (once per 1.3 seconds) and sending message rates are
standard (once per 0.04 seconds). A MultiHop device is set from the factory with the retry parameter set to 8. This means
that under worst-case conditions, a message is sent from the DXM Controller to an end device a total of nine times (one
initial message and eight retry messages. The end device sends the acknowledgement message back to the DXM
Controller a maximum of nine times (one initial message and eight retries). A single Modbus transaction may send up to
two messages + 16 retry messages before the transaction is complete. In addition, the radios randomly wait 0—1 time
period before retransmitting a retry message. So to allow for the random wait time, add one extra time period for each in-
between time of retries.

For a Master radio to a slave radio (no repeaters):

= Master to Slave Send time = (9 x 1.3 sec) + (8 retry wait % 1.3 sec) = 22 seconds
= Slave to Master Send time = (9 x 0.04 sec) + (8 retry wait x< 0.04 sec) = 1 second
= Total Send/Receive time = 23 seconds
= Minimum Timeout period = 23 seconds

This calculates the maximum timeout value for a wireless transaction. If the link quality of the network is poor, the
maximum transfer times may happen. Set the timeout parameter to accommodate the maximum number of retries that
may happen in your application.

When MultiHop repeaters are added into the wireless network, each additional level of hierarchical network increases the
required timeout period. Since MultiHop repeaters are running at the highest communications rate, the overall affect is not
as great.

= Master to Repeater Send time = (9 x 0.04 sec) + (8 retry wait < 0.04 sec) = 1 second
= Repeater to Master Send time = (9 x 0.04 sec) + (8 retry wait < 0.04 sec) = 1 second
= Additional Timeout period for a repeater = 2 seconds

Using the timeout calculation above of 23 seconds, if a repeater is added to the network the timeout should be set to 25

seconds. For each additional MultiHop repeater device creating another level of network hierarchy, add an additional two
seconds to the timeout period.

4.5 Line-Powered MultiHop Devices

Line-powered (10-30 V dc) MultiHop devices operate at the maximum communication rate, resulting in a much lower
timeout parameter setting. For each repeater added to the network, increase the timeout parameter 2 seconds.

For a Master radio to a line powered slave radio (no repeaters):
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= Master to Slave Send time = (9 x 0.04 sec) + (8 retry wait < 0.04 sec) = 1 second
= Slave to Master Send time = (9 x* 0.04 sec) + (8 retry wait % 0.04 sec) = 1 second
* Total Send/Receive time = 2 seconds

= Minimum Timeout period = 2 seconds

4.5 Adjusting the Receive Slots and Retry Count Parameters

The number of receive slots governs how often a MultiHop device can communicate on the wireless network. Battery-
powered devices typically have DIP switches that allow the user to set the number of receive slots. (This will directly affect
the battery life of the device.) Adjusting the receive slots changes how often a message can be received. In the battery
power example (default factory settings) the receive slots are 1.3 seconds (receive slots = 4). With the receive slots set to
32, how often a message can be received goes from 1.3 seconds down to 0.16 seconds.

An argument can be made to allow the application accessing the wireless network, in this case the DXM Controller, to
control the retry mechanism. The number of retries can be adjusted in the MultiHop devices by writing Modbus register
6012 to the number of retires desired. The factory default setting is eight.

4.5 DX80 Star Architecture Network Timeouts

The DX80 star network of a Gateway and Nodes can be treated differently with respect to timeout conditions. The DX80
star network is much different from a MultiHop network. In the DX80 network, all Node data is automatically collected at
the Gateway to be read. The DXM Controller does not use the wireless network to access the data, which allows for much
faster messaging and much lower timeout values. For a DXM Controller with an internal DX80 Gateway, set the timeout
value 0.5 seconds. If other Modbus slave devices are connected to the RS-485 lines, the timeout parameter will govern all
communication transactions and must be set to accommodate all devices on the bus.
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5 Configuration Instructions

5.1 Working with Solar Power

A reliable solar system requires careful planning and monitoring to size the components correctly. The recommendations
provided are for the DXM Controller system as an autonomous system. Adding extra components increases the power
requirements and likely requires increasing the solar system components. Depending upon the geographical location, the
size of the solar panel and battery may vary.

5.1 Setting the DXM Controller for Solar Power

By default, the DXM Controller is set from the factory to charge a backup battery from a line power source. Using the LCD
menu on the front of the DXM Controller to change the charging algorithm to solar power.

Go to System > Power Select. Change the Power to Solar.

Power Select 08:25:45

Power: [DC]

+ + Change Power Select
<Ent> Accept
<Back> Previous Menu

There are a few DXM configuration tips to help minimize the power consumption.
« If Ethernet is not being used, save up to 25% of the consumed power by disabling Ethernet on the DXM Controller.
Set DIP switch 1 to the ON position on the processor board then reboot the DXM Controller.
= Instead of powering external devices all the time, take advantage of the switched power mechanisms of the DXM
Controller to turn off devices when possible.
= Minimize the number of cellular transactions and the amount of data pushed across the cellular modem.

5.1 Solar Components
Battery Properties

The DXM solar controller is designed to use a 12 V lead acid battery. The characteristics of a solar system require the
battery to be of a certain type. There are basically two types of lead acid batteries:

= SLI batteries (Starting Lights Ignition) designed for quick bursts of energy, like starting engines
= Deep Cycle batteries - greater long-term energy delivery. This is the best choice for a solar battery.

Since a solar system charges and discharges daily, a deep cycle battery is the best choice. There are different versions of a
lead acid battery: wet cell (flooded), gel cell, and an AGM (absorbed glass mat).

Wet cell batteries are the original type of rechargeable battery and come in two styles, serviceable and maintenance free.
Wet cell batteries typically require special attention to ventilation as well as periodic maintenance but are the lowest cost.
The gel cell and AGM battery are sealed batteries that cost more but store very well and do not tend to sulfate or degrade
as easily as a wet cell. Gel or AGM batteries are the safest lead acid batteries you can use.

Battery Capacity

Battery capacity is a function of the ambient temperature and the rate of discharge. Depending upon the specific battery, a
battery operating at —30 °C can have as much as 40 percent less capacity than a battery operating at 20 °C. Choose
enough battery capacity based on your geographical location.
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A larger capacity battery typically lasts longer for a given solar Use this as a guide to the approximate state of charge and in
application because lead-acid batteries do not like deep cycling determining when to apply conservation measures.
(discharging a large percentage of its capacity). Depending upon the
battery, a battery discharging only 30 percent of its capacity before Average Voltage Readings Relative to Battery
recharging will have approximately 1100 charge/discharge cycles. The Change
same battery discharging 50 percent of its capacity will have S on N o cireat |
approximately 500 charge/discharge cycles. Discharging 100 percent EAED @i CETED (26) [PEm CIEUEYAEEE
leaves the battery with only 200 charge/discharge cycles. 100 13.0 or higher
Batteries degrade over time based on discharge/charge cycles and 75 12.6
environmental conditions. Always monitor the battery system to obtain
the best performance of the solar powered system. 50 12.1

25 11.66

0 11.4 or less

Solar Panels

Banner solar panels come in two common sizes for the DXM Controller: 5 Watt and 20 Watt. Both panels are designed to
work with the DXM Controller but provide different charging characteristics. Use the 5 watt panel for light duty operation
and use the 20 watt panel when you require greater charging capabilities.

Solar Panel Voltage Current Typical DXM Configurations
5 Watt 17 Vv 0.29 A DXM slave controller, ISM radio, 1/0 base board
20 Watt 21V 1A DXM Controller with 1SM radio and Cellular modem

Photovoltaic panels are very sensitive to shading. Unlike solar thermal panels, PV solar panels cannot tolerate shading
from a branch of a leafless tree or small amounts of snow in the corners of the panel. Because all cells are connected in a
series string, the weakest cell will bring down the other cells' power level.

Good quality solar panels will not degrade much from year to year, typically less than 1 percent .
Solar Panel Mounting

To capture the maximum amount of solar radiation throughout the year, mount a fixed solar panel to optimize the sun's
energy throughout the year. For the northern hemisphere, face the panel true south. For the southern hemisphere, face
the panel true north. If you are using a compass to orientate the panels, compensate for the difference between true north
and magnetic north. Magnetic declination varies across the globe.

A solar panel's average tilt from horizontal is at an angle equal to the latitude of the site location. For optimum
performance, adjust the tilt by plus 15 degrees in the winter or minus 15 degrees in the summer. For a fixed panel with a
consistent power requirement throughout the year, adjust the tilt angle to optimize for the winter months: latitude plus 15
degrees. Although in the summer months the angle may not be the most efficient, there are more hours of solar energy
available.

For sites with snow in the winter months, the increased angle helps to shed snow. A solar panel covered in snow produces
little or no power.
5.1 Recommended Solar Configurations

These solar panel and battery combinations assume direct sunlight for two to three hours a day. Solar insolation maps
provide approximate sun energy for various locations. The depth of battery discharge is assumed to be 50 percent.

Solar panel and battery combinations for a DXM Controller system

Solar Panel Battery Capa(:ity3 Days of Autonomy DXM mA DXM Controller
5 watt 10 Ahr 10 days 25 mA DXM Slave Controller - ISM radio and 1/0 base board
20 watt 14 Ahr 10 days 30 mA DXM Controller with ISM radio

3 Battery capacity (amp hour) is standard amp rating taken for 20 hours. Battery capacity should be monitored for reliable system power and may
need to be increased for cold weather locations.
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Solar panel and battery combinations for a DXM Controller system

Solar Panel Battery Capacity3 Days of Autonomy DXM mA DXM Controller

20 watt 20 Ahr 10 days 35 mA DXM Controller with ISM radio and Cellular Modem

5.1 Monitoring Solar Operation

The DXM solar controller provides Modbus registers that allow the user to monitor the state of the solar panel input
voltage, the battery voltage, the charging current, and the temperature in °C. The DXM Controller can be configured to
monitor the health of the charging system as well as send an alert message when the battery is too low.

The charts show a typical charging cycle, with each vertical grid representing about eight hours. The chart shows three
days of charging.

.-
-
oy

Figure 1. Solar Panel Voltage (mV) -- Cloudy First Day

Figure 2. Battery Voltage (mV) - Cloudy First Day

5.2 Inputs and Outputs

The 1/0 base board is a Modbus slave device (Slave ID 200) that communicates to the processor board using Modbus
commands. Use the DXM Configuration Tool to create a configuration using read/write maps that will access inputs or
outputs on the 1/0 board.

Communication with the 1/0 board runs at a maximum rate of 10 ms per transaction. The parameter setting for the bus
with the 1/0 board and the processor board are fixed. External Modbus communication runs at a maximum rate of 50 ms
per transaction. The parameter settings for the external RS-485 buses are controlled by the DXM Configuration Tool.

Refer to the Modbus Registers section for more descriptions of each Modbus register on the DXM100 Controller.

5.2.1 Universal Inputs

The universal inputs on the DXM100 Controller can be programmed to accept several different types of inputs:
« Discrete NPN/PNP

3 Battery capacity (amp hour) is standard amp rating taken for 20 hours. Battery capacity should be monitored for reliable system power and may
need to be increased for cold weather locations.
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= 0 to 20 mA analog

= O to 10V analog

= 10k temperature thermistor
= Potentiometer sense

e Bridge

e NPN raw fast

Any input can be used as a synchronous counter by configuring the input as a discrete NPN/PNP input.

Use the DXM Configuration Tool tool to write to the appropriate Modbus registers in the 1/0 board to configure the input
type. The universal inputs are treated as analog inputs. When the universal inputs are defined as mA, V, or temperature,
use Modbus registers to configure the operational characteristics of the inputs. These parameters are temperature
conversion type, enable full scale, threshold and hysteresis. Refer to the DXM100 Controller Instruction Manual (p/n
190037) for the parameter definitions.

When a universal input is configured as an NPN or PNP input type, it can be enabled to be a synchronous counter. Enable
the counter function by setting Modbus register ‘Enable Rising' or ‘Enable Falling’ to 1. See 1/0 Base Board (Modbus Slave
200) on page 52 for universal input register definitions.

Pin Univ. Input

Description

27 Universal Input 4 Program the universal inputs to accept input types NPN, PNP, 10k thermistor, O to 10 V, O to
: 20 mA, or potentiometer. The default setting is 8: NPN raw fast. To set the input type, write

28 Universal Input 3 the following values to the Input Type Modbus registers defined in 1/0 Base Board (Modbus
31 Universal Input 2 Slavg io[\(l)g'\?n page 52.

1 =PNP

2 =0to 20 mA

3=0to 10V dc
32 Universal Input 1 g f il?)lt( JQ:ém'Stor

6 = Not used

7 = Bridge

8 = NPN Raw Fast (default)

Thermistor Input

Potentiometer
Input

Bridge Input

NPN vs NPN Raw
Fast

Synchronous
Counters

A thermistor input must use a 10k temperature thermistor between ground and the universal
input. The thermistor must be a 10k NTC (Banner model number BWA-THERMISTOR-002) or
equivalent. Select the temperature conversion of degrees C (default) or degrees F by writing
Modbus registers defined in 1/0 Base Board (Modbus Slave 200) on page 52.

A potentiometer input is created from three inputs: a voltage source (pin 30) that supplies 5 V to
the potentiometer and two inputs set to voltage inputs to read the voltage across the
potentiometer. See the DXM tech note for setting up a potentiometer.

The bridge input is not implemented yet.

The difference between NPN and NPN Raw Fast is the amount of settling time given to the input.
Switch the input type to NPN if the input is not detecting a transition.

When an input is configured as a counter (inputs set to NPN/PNP), the input counts the input signal
transitions. The count value is stored into two 16-bit Modbus registers for a total count of 32-bits
(unsigned). To program an input to capture the edge transition counts, follow Example: Configure
Input 1 as a Synchronous Counter on page 26.

Synchronous counter sample the inputs every 10 ms. The input logic does not detect rising or
falling edges, but instead samples the input every 10 ms to find level changes. The input signals
must be high or low for more than 10 ms or the input will not detect transitions. Because most
signals are not perfect, a realistic limit for the synchronous counter would be 30 to 40 Hz.

1. Connect the DXM Controller to the PC.

wnN

Launch the DXM Configuration Tool software.
Connect to the DXM Controller by selecting the Device > Connection Settings menu option. You may connect using

either USB or Ethernet.

NG A

26

Select a COMM port from the drop-down list and click Connect.

Click on the Register View tab on the left part of the page.

Change the Source Register selection to 1/0 Board Registers.

In the Write Registers area, write Modbus register 4908 to 1 to enable counting on the rising edge of the input signal.
Read Modbus registers 4910 and 4911 to get the 32-bit value of the count.
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Connect the DXM Controller to the PC.
Launch the DXM Configuration Tool software.

Connect to the DXM Controller by selecting the Device > Connection Settings menu option. You may connect using
either USB or Ethernet.

Select a COMM port from the drop-down list and click Connect.

Click on the Register View tab on the left part of the page.

Change the Source Register selection to 1/0 Board Registers.

Write a 3 to Modbus register 3326 on Modbus Slave ID 200 (1/0 board).
Cycle power to the device.

Using the Register View tab, read register 3326 to verify it is set to 3.

Connect the DXM Controller to the PC.
Launch the DXM Configuration Tool software.

Connect to the DXM Controller by selecting the Device > Connection Settings menu option. You may connect using
either USB or Ethernet.

Select a COMM port from the drop-down list and click Connect.

Click on the Register View tab on the left part of the page.

Change the Source Register selection to 1/0 Board Registers.

Set jumper 1 on the 1/0 base board to the O to 10 V position. Refer to the base board image for the analog output
jumper position.

Write a 3 to Modbus register 4008 on Modbus Slave ID 200 (1/0 board).

Cycle power to the device.

10. Using the Register View tab, read register 4008 to verify it is set to 3.

5.2.2 NMOS Outputs

Pin Output Description Wiring

22 NMOS Discrete Output 4
Output

Less than 1 A maximum current at 30 V dc
ON-State Saturation: Less than 0.7 V at 20 mA
ON Condition: Less than 0.7 V
OFF Condition: Open

23 NMOS Discrete Output 3 4‘
24 NMOS Discrete Output 2

35 NMOS Discrete Output 1

5.2.3 Analog (DAC) Outputs

The analog outputs may be configured as either O to 20 mA outputs (default) or O to 10 V outputs.

To change the analog (DAC) output type:

1. Remove power to the device.

Unplug both the USB and Ethernet connections.

Remove the DXM cover.

Change the hardware jumper position (see the table for the pin number and 1/0 Base Board Connections on page
13 for the pin locations).

Replace the DXM cover.

Plug in both the USB and Ethernet connections.

Restore power to the DXM.

Set the Output Type Select Modbus register (on the 1/0 board, Slave ID 200) to a value of 2 (default) to select O to
20 mA or a value of 3 to select O to 10 V. For analog output 1 write to Modbus register 4008, for analog output 2
write to Modbus register 4028 (see the table for the values).

PON

®Noa
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Pin  Output Modbus Description
Register
19 | Analog Output 1 4008 0 to 20 mA or 0 to 10 V dc output (I/0 board jumper selectable)

Accuracy: 0.1% of full scale +0.01% per °C
Resolution: 12-bit

20 | Analog Output 2 4028 After changing the jumper position, write the appropriate value to the Modbus
registers to define your analog output to match the setting selected by the jumper.
2 = 0 to 20 mA output (default)
3 =0 to 10 V output

5.3 Scheduler

Use the Scheduler tab to create a calendar schedule for local register changes. Use this tab to define the days of the
week, start time, stop time, and register values. Schedules are stored in the XML configuration file, which is loaded to the
DXM Controller. Reboot the DXM Controller to activate a new schedule.

5.3 Weekly Schedules

Define weekly events using the weekly events screen.

e Femetos Weekly Events | eLERINERSVELTSY BRlIIGE NS

‘ Add Weekly Event‘ ‘ Delete Last Evant‘

Register Mapping

() Weekly event 1 None  Active days: [JERAMEPEFEN  start 1 at 22:00:00 End: 0 at NONE

Schedule Definition Holidays

. Active Holidays Available Holidays
Action Rules Stari Value: 1 % Startat (SpecificTime |~ 22:00 $ 24 hour format ad ]

[0 End Value: 0 End at: (Specific Time | 0001 24 hour format Remove

Scheduler

Register View days
Active Holidays Available Holidays
Start Value: 0 % Startat (SpecificTime )~ 0200 £ 24 hour format Add
Settings [T} End Vaiue 0 % Endat (SpecificTime ] ~| 00:01 = 24 hour format Remove

To create a new rule:

1. Click Add New Rule.

Click on the arrow to the left of the new rule to expand the parameters into view.

Enter the local register.

Select the days of the week this rule applies to.

Use the drop-down list to select the type of Start At time: a specific time or a relative time.
Enter the starting time.

Enter the starting value for the local register.

Enter the end time and end value for the local register.

NGO RGN

Register updates can be changed up to two times per day for each rule. Each rule can be set for any number of days in the
week by clicking the buttons M, T, W, Th, F, S, or Su.

If two register changes are defined for a day, define the start time to be before the end time. Select End Value to enable
the second event in a 24 hour period. To span across two days (crossing the midnight boundary), set the start value in the
first day, without selecting End Value. Use the next day to create the final register state.

Start and end times can be specified relative to sunrise and sunset, or set to a specific time within a 24 hour period. When
using sunrise or sunset times, set the GPS coordinates on the device so it can calculate sunrise and sunset.
5.3 One-Time Events

Define one-time events to update registers at any time within a calendar year. Similar to Weekly events, the times can be
specific or relative to sunrise or sunset. Define one-time events using the one-time events screen.
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L (RS LEEISVEN TS | One Time Events | JBIIGEYS

| Add One Time Event | | Delete Last Event |

Register Mapping |} ) B Register Number [JIESRE] Nore Start 1 at 017202016

Event Definition

DAWN-60 End: 0 at 0172072016 DUSK+720

Action Rules Start Value: 1% Stanat (Relative Time| ~ | Wednesday, January 20,2016 # [~ 01:00 £ HH:mm (Before | ~ | (Sunrise | ~

[ End Value: 0% Endat (Relative Time) v | Wednesday, January 20,2016 5[ | 1200 3 HH:mm [Afler | ~| (Sunset |~
Scheduler

Register View

Settings

To create a one-time event rule:

oukwnN

Click on Add One Time Event.

Name your one-time event by clicking on the name link and entering a name.
Click on the arrow to expand the parameters into view.

Enter the local register.

Enter the starting time, date, and starting value for the local register.

Enter the ending time, date, and ending value for the local register.

5.3 Create Holiday Schedules

Use the Create Holidays tab to create exception conditions that alter the standard scheduled register changes.

L s e Weekly Events | One Time Evenis | izl =%

i’;ﬂd Holiday ‘ | Delete Last Holiday |

Register Mapping [(ECS Now Holiday S Wednesday, January 20, 2016 12:00 AM 3 |~ IEINH Wednesday, January 20, 2016 12:01 AM % |~

Action Rules

Scheduler

Register View

Settings

To create a holiday:

1.

2.
3.
4

Click on Add New Rule.

Name your new holiday by clicking on the name link and entering a name.
Select the start date and time for the new holiday.

Select the stop date and time for the new holiday.

5.3 Power Cycling During Schedules

If power is cycled to the DXM Controller in the middle of a schedule, the DXM Controller will look at all events scheduled

that day and process the last event before the current time.
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5.4 LCD and Menu System

Banner Eng 08:25:45

0 - Registers
- Push S - 08:25:15

- ISM Radio

- System
0 - System Info

The LCD has four user-defined LED indicators, four control buttons, and
an LCD display. The four buttons control the menu system on the LCD

menu. The top-level menu always displays the time in a 24-hour
@ format.
e The up and down arrows scroll through display items.

= The enter button selects the highlighted items on the display
« The back button returns to a previous menu option.

The left display column shows an arrow at the beginning of the line if the menu has submenus. The right column shows a
vertical line with an arrow at the bottom if the user can scroll down to see more menu items.

5.4 Registers

The Registers submenu displays the processor's local registers that

can be configured using the DXM Configuration Tool.

To configure these local registers, launch the DXM Configuration Registers 08:25:45
Tool. Go to Local Registers and expand the view for a local register > 1 on/off:DoorAlarm5

by clicking on the down arrow next to the register number. In the > 0 on/off: Door Switch5

LCD Permissions field, select None, Read, Write, or Read/Write. 213 mA: Tank Level

16.60 V: Solar Voltage In
450 mA: Solar Current In
13.28 V: Battery Voltage In

Read allows the register to be displayed, and Write or Read/Write allows the register value to be changed using the LCD.
The Units and Scaling parameters are optional and affect the LCD.

5.4 Push

The Push menu displays information about the last data sent to the

Webserver. The user can force an immediate push to the webserver using
Trigger Push. If a current push is in process it may take several minutes

to complete over cellular. Push 08:25:45
e The Trigger Push submenu forces an immediate push to the web -> Trigger  Data Push
server. Status: Success
e The status and time fields indicate success or failure of the last Time: 09:25:15

attempted push and time of the last attempted push.

30
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5.4 ISM Radio

The ISM Radio menu allows the user to set the Modbus Slave ID of the

internal ISM radio, invoke binding, or run a site survey. The controller

automatically detects the ISM Type. ISM Radio 08:25:45
ISM Type (radio type)—The factory sets this field based on the model ISM Type: MultiHop
number of the DXM Controller. If the ISM type is incorrect or if the user is ->|SM Slave ID : 1

installing a radio for the first time, set the ISM type from the System menu. -> Binding

The ISM radio types are MultiHop (Tree architecture with repeaters) or DX80 -> Site Survey

(Star architecture).

I1SM Modbus ID—The factory default of the internal ISM radio is set to Modbus ID 1. Typically this does not have to be
changed. The DXM Controller is configured to have the first 10 Modbus IDs reserved for the hardwired Modbus devices.
Modbus IDs 11 through 110 are reserved for the wireless Modbus devices. If required, use this menu to change the
Modbus ID for the internal radio.

Binding— All ISM radio devices must be bound to the internal Gateway/master device before the DXM Controller can
access the wireless devices. The first submenu under binding allows the user to set the wireless address of the device to
bind with. This is required to bind with wireless devices that do not have rotary dials (for example: M-GAGEs, Ultrasonic
sensors, and Q45 devices).

To bind:
1. Enter the Binding menu. Binding 08:25:45
2. For devices without rotary dials, select the wireless device number. Bind o> 1
3. Enter binding mode. The gateway/master radio enters binding mode.
4. Triple-click the wireless Node/slave device to put it into binding
mode. The LEDs indicate when binding on the wireless device is T¢Change Device #
completed. <Ent> Start Binding
. . - . . . <Back> End Binding
For more information of the binding of a particular device review the

individual datasheet.

Site Survey— After creating a wireless network using the binding process, run a site survey on each device to see the link
quality.

1. Enter the Site Survey menu.

2. Select the Node or Slave ID for the end device.

3. Click Enter to run a site survey.

Site  Survey 08:25:45
Node/Slave  ID
> Site Survey 08:25:45
T$Change Device # )
<Ent> Run Site Survey Please Wait...
S0 A El 3, St Suney 08:2545
Device #
Grn :45 Yiw:15
Red: 15 Miss: 25

<Back> Previous Menu

The Site Survey results display as green, yellow, red, and missed packets. Green indicates the highest signal strength,
then yellow, and red. MIssed packets failed to be received. The DX80 system can run a site survey analysis while the
network is operational. A MultiHop device runs with its parent device and does not allow other traffic when a site survey is
running.
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5.4 System

The System menu is for setting DXM Controller system parameters.

ISM Radio— Allows the user to change the ISM radio type and ISM Modbus ID.

The radio type selections include None, DX80, or MultiHop. The radio type
defines how the DXM Controller controls the site survey and binding functions System 08:25:45
on the internal radio.  1SM Radio
. L . . - Ethernet
The internal ISM radio is set to Modbus ID 1 from the factory. Typically this - Provision Cell
does not have to be changed. The DXM Controller is configured to reserve the -> DXM Slave ID: 255
first 10 Modbus ID for hardwired Modbus devices. Modbus IDs 11 through 110 - Power: [dc / solar]
are reserved for the wireless Modbus devices. If required, use this menu to -> LCD Contrast: 28
change the Modbus ID for the internal radio. > Restart

Ethernet—Use the System > Ethernet menu to set the IP Address, Gateway Address, and Subnet mask of the DXM
Controller's Ethernet interface. You may change these settings either from the LCD menu (System > Ethernet) or from
the XML configuration file created by the DXM Configuration Tool.

The network address settings from the LCD menu have the highest priority and override settings in the XML configuration
file. To use the parameter settings from the XML configuration file or use DHCP, execute the Reset under System >
Ethernet or use the LCD display to set the IP Address, Gateway Address, and Subnet Mask to 255.255.255.255. Reboot
the DXM Controller after changing the Ethernet parameters.

The Ethernet cable should be attached before powering up the DXM Controller.

Provision Cell— If the DXM Controller has a cellular modem installed, the modem must be provisioned on the network.
This menu will provision the cellular modem on the network. For step by step directions, see Cellular Activation Quick Start
Guide on page 37.

DXM Slave ID— The secondary Modbus RS-485 port is used when the DXM Controller is connected to a Modbus RTU
network as a Modbus slave device. Set the Modbus ID for the secondary RS-485 port using the LCD display menu System
> DXM Slave ID.

Power DC/Solar— The DC/Solar parameter selects the charging algorithm for batteries attached to the DXM Controller.
The factory default setting is DC.

Set the charging algorithm to Solar when the main power source is a solar panel and batteries. Set the battery charging
algorithm to DC when the main power source is line powered 10—30 V dc and the attached batteries are used as backup
batteries. This setting can also be set by writing Modbus register 6071 of the 1/0 board. See Supplying Power from a Solar
Panel on page 15.

LCD Contrast— Adjusts the LCD contrast. Adjust the starting number lower to decrease the display contrast. The factory
default is 28. Do not set a number less than 14 or the display may not be bright enough to see to change back.

Restart— Forces the main processor to restart. This does not affect the other boards in the system, 1/0 board, ISM radio
board, or Cellular modem.

5.4 System Info

Various DXM system settings are shown in this menu. The Push, Ethernet, and Cell parameters are helpful for debugging
network connections. This menu is a read only menu.
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Controller Displays the date, build, model, and serial number.

ISM Radio Displays the serial pumber, model, date, firmware part System Info 08:25:45
numbers, and version numbers.
- Controller
Push Shows the current parameters loaded from the XML > ISM Radio
configuration that applies to pushing data to a webserver, - Push
including method (Ethernet or cellular), interval, URL, page, - Ethernet
HTTPS, and site ID. - Cell
- /0 Board
Ethernet  Displays the IP address, MAC address, DHCP, Gateway - LCD Board

address, and DNS settings.

Cell Shows the cellular MEID number (Mobil Equipment Identifier),
MDN (Mobil Device Number), version, signal, firewall setting,
and firewall mask. Some of these parameters are not visible
until the cellular network is accessed.

1/0 Board Displays the serial number, model, date, firmware part
numbers, and version numbers.

LCD Board Displays the serial number, model, date, firmware part
numbers, and version numbers.

5.5 Authentication Setup

The DXM Controller has three different areas that can be configured to require a login and password authentication.
= Webserver/ Cloud Services Authentication
« Mail Server Authentication
= DXM Configuration Authentication

The webserver and mail server authentication depends upon the service provider.

5.5 Webserver/Cloud Services Authentication

The DXM Controller can be configured to send login and password credentials for every HTTP packet sent to the webserver.
This provides another layer of security for the webserver data.

Setup requires both the webserver and the DXM Controller to be given the same credentials for the login and password.
The webserver authentication username and password are not stored in the XML configuration file and must be stored in
the DXM Controller.

Ok Define the login and password using the Settings > Cloud Services screen
of the DXM Configuration Tool, in the Webserver Authentication section
Webserver Authentication of the screen.

Usemame: | | The first time you select Require Authentication, a pop-up box appears
with additional instructions. Since the data is not stored in the XML
configuration file, it is hidden from view of the DXM Configuration Tool.

Password. \ |

Send Authentication

After enter the username and password, click on Send Authentication to transmit the data directly to the DXM
Controller's non-volatile memory. The controller must be connected to the PC for this operation to succeed. If successful, a
pop-up window appears, asking to reboot the device. Select Yes to reboot the device.
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dit site ' Set up the webserver with a username and password to accept the DXM
Controller messages. Otherwise, the webserver ignores all messages.
Steame: | Mutito. 1 When using the Sensonix website's dashboard, set the authentication by
L (e A e L e clicking the edit button next to the appropriate site name. Enter the
e | B O Username and Password, then click Save to save your changes.

5.5 Mail Server Authentication

Complete the mail server settings to have the DXM Controller send email alert messages or to email the log files. The
SMTP password is stored in the DXM Controller, not the XML configuration file. Use the Settings > Mail and Messaging
screen to complete this configuration.

Mail Server Settings

SMTP Server smipmail visi.com | [%] Enable SMTP Authentication
SMTP Server Port: 587 % User Name: | device@sensonix.com |
Password: | DevcePassword |
| Send SMTP Password |

After selecting Enable SMTP Authentication for the first time, a pop-up box appears with additional instructions to
complete the mail server authentication process.

After entering the user name and password, click on Send SMTP Password to save the user name and password to the

DXM Controller. The DXM Controller must be connected to the PC to complete this operation. If successful, a pop-up
window appears, asking to reboot the device. Select Yes to reboot the device.

5.5 DXM Controller Configuration Authentication

The DXM Controller can be programmed to allow changes to the configuration files only with proper authentication by
setting up a password on the Settings > Administration screen in the DXM Configuration Tool.

General | Cloud Services || Logging | Scripting | Network | Mail and Messaging Acl

File Protection

Local Registers

Register Mapplng Get Device Status | Unknown
Current Admin Password
Action Rules
Action: | ) -

Scheduler
Comm Port: - E‘

File Path: | | |

Bootload

Register View
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With the DXM Controller connected to the PC, click Get Device Status. The DXM Controller status displays next to the
button.

Use the DXM Configuration Tool to:
e Set the Admin Password
= Change the Admin Password
e Remove the Admin Password

To change or remove an admin password, the current password must be supplied. The DXM Controller must be connected
to the PC to change the administration password.

The DXM Controller can be unlocked without knowing the administration password, but doing this erases the configuration
program, logging files, and any ScriptBasic program on the device.

To unlock the hardware without knowing the administration password:

1. Turn off the power to the DXM Controller.

Open the controller top to access the button and DIP switches of the SAM4 processor board.

Turn on DIP switch 4 (next to the SD card holder).

Press and hold the reset button (next to the USB jack) while applying power to the DXM Controller.
Release the reset button.

After five seconds, turn off the power.

Turn off DIP Switch 4.

8. Install the DXM cover and apply power.

NoorON

The device no longer has an administration password set.

5.6 Register Flow and Configuration
The DXM Controller register data flow goes through the Local Registers, which are data storage elements that reside within

the processor. Using the DXM Configuration Tool, the controller can be programmed to move register data from the Local
Register pool to remote devices, the internal radio, the 1/0 base, or the display.

———————

Processor

Local
- .
Ethernet/USB/Cellular RS

1/0 Base

Remote Devices

Internal
Radio

Display

5.6 Basic Approach to Configuration

When programming an application in the DXM Controller, the first step is to plan the overall data structure of the Local
Registers. The Local Registers are the main storage elements in the DXM Controller. Everything goes into or out of the
Local Registers. Start by naming the Local Registers in the application as this helps to provide the beginning structure of
the application.

After you have a basic idea what data values to store, configure the read/write rules to move the data. The Read/Write
rules are simple rules that move data between devices and the Local Registers.

Most applications require the ability to manipulate the Local Register data, not just move data around. Use the Action rules

to make decisions or transform the data after the data is in the Local Registers. Action rules can apply many different
functions to the Local Register data, including conditional statements, math operations, copy operations, or trending.
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To perform scheduled events in Local Registers, look under the Scheduler tab in the DXM Configuration Tool. These rules
provide the ability to create register events by days of the week. The scheduler can also create events based on sunrise or
sunset.

5.6 Troubleshooting a Configuration

The built-in Register View utility is found in the DXM Configuration Tool under the Register View tab. When a
configuration is running on the DXM Controller, this utility can read or write Local Registers to help understand application
operation. The utility can also access data from remote devices, making it easier to troubleshoot a configuration.

Local Registers can be configured to show register data on the LCD menu. This is another method to view Local Register
data without having the controller connected to a PC. On the Local Registers tab, set the read permissions on each
register to be display on the LCD.

5.6 Saving and Loading Configuration Files

The DXM Configuration Tool saves its configuration information in a XML file. Use the File menu to Save or Load
configuration files. Make sure to save the configuration file before attempting to upload the configuration to the DXM
Controller. The DXM Configuration Tool uploads the configuration file saved on the PC to the DXM Controller; it will not
send the configuration loaded in the tool.

5.6 Uploading or Downloading Configuration Files
The DXM Controller requires a XML configuration file to become operational. To upload or download configuration files,

connect a computer to the DXM Controller using the USB port or Ethernet port. Then use the Upload Configuration to
Device or Download Configuration from Device under the Device menu.

5.7 DXM Cellular Modem

The DXM cellular modem provides a remote network connectivity solution for the DXM Controller.

To use the cellular modem, first configure the DXM Controller to use the cellular network as the external network
connection. Verify the cellular modem is installed and the correct antenna is connected to the cellular antenna port.

5.7 Configure the DXM Controller for a Cellular Modem

Use the DXM Configuration Tool to create a configuration using a cellular connection. Under Settings > Cloud Services,
define the Network Interface as Cell to have all push data, SMS messages, or email alerts to be sent using the cellular
modem. The Cloud Push settings and the Webserver settings are required if the DXM Controller is sending data to a
webserver.

Local Registers General JlelIGESIEWNWRE | ogging | Scripting | Network | Mail and Messaging | Administration

T
Register Mapping Ethernet | = TR Server Name/IP: | push.sensonix.net ‘
Cloud Push Page: | rpush.aspx ‘
- Cloud Push Interval: 0015 % HH:mm .
Action Rules Host Header: | |
T oo-00 HHMM || Site 1D: | Clear| 00000000-0000-0000-0000-DO00000GD000
Scnoder ([t (N
[ Require Authentication [ Use HTTPS

s Certificate CN:  * sensonix net

Register View

Password:
Send Authenfication
Settings

When the DXM Controller is configured to use the cellular modem, the information on the cellular modem is found on the
LCD menu under System Info > Cell. The menu does not display values until a transaction with the wireless cell tower is
complete. If there are no webserver parameters defined, the user must force a push to retrieve the data from the cellular
network. On the LCD menu, select Push > Trigger Data Push.

S5L Port: 443
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FW Firewall IP address setting for VPN connection. The user enters the IP address of the host system on the other
end of the VPN connection.

Mask IP mask associated to the firewall IP address

MEID Mobile Equipment Identifier—a unique number for each cellular modem; this is the number the wireless carrier
uses to attach a wireless plan

MDN Mobile Device Number—phone number

Signal Signal Strength between the cellular modem and the wireless network tower; this value ranges between —51
and —112 dBm. The more positive number is better, —51 is better than —81.

Version Firmware version of the cellular modem; this can only be updated at the factory

5.7 Cellular Activation Quick Start Guide

Sensonix CDMA cellular modems (based on the Telit CE910-DUAL) are ready to be activated when they leave the factory.
Successful activation of every device on the cellular network requires two basic steps:

1. Attaching a data plan to the particular device
2. Completing Over-the-Air Service Provisioning (OTASP)

To attach a cellular data plan:

1. Select a data plan with a carrier that uses the Verizon network, working with Verizon directly or using an MVNO
such as M2MAIir or KORE Telematics.

2. Set up an account with the selected carrier.

3. When working with cellular devices you may be required to log into a web portal provided by the carrier and follow
their instructions for device activation.

4. It is very important to make sure the carrier knows that the data plan is being attached to the device known as
SENSXO0O01.

5. Remove the DXM100 housing cover to see the cellular modem. Use the MEID printed on the Telit CE910-DUAL
cellular modem to uniquely identify the device. The carrier requires this number to attach a monthly data plan.

To complete the Over-the-Air Provisioning (OTASP)

1. Once the contract is attached, the DXM Controller must provision the service using OTASP (Over-the-Air Service
Provisioning).

Make sure the cellular module is plugged into the DXM Controller and has its antenna properly connected.

On the DXM Controller LCD display select menu: System and then Provision Cell.

Click Enter on the Provision Cell menu.

The next screen will ask if you want to provision the cellular device, click Enter.

It will take approximately 60 seconds and will indicate when it has completed.

The cellular modem is ready for use.

Noghen

5.7 DXM Cellular VPN Setup

A software VPN tunnel can be created between a DXM Controller using a cellular modem to a host PC using a private IP or
static wireless cellular plan. The instructions below outline the DXM Controller set up required to become aware of the VPN
connection. The cellular plan provider will have separate instructions for setting up the VPN on the PC side.

1. Establish VPN tunnel on your computer. Instructions should be provided from your VPN provider.

2. From within the DXM Configuration Tool, go to Settings > Network > Cellular Firewall Settings..

Fill in the Firewall IP address and Firewall netmask provided by your VPN provider. For M2Mair this was
included in the Routes.cmd file. It opens the device to traffic from 172.16.1.[0-255].

Go to Settings > Cloud Services > Network Interface.

Select Cell from the drop-down list and select the Enable VPN checkbox.

With your VPN tunnel open, select Device > Connection Settings.

Select TCP/IP, enter your VPN IP address, check VPN, and click Connect.

w

No ok

5.8 Binding and Conducting a Site Survey with the ISM Radio

The DXM Controller can have an internal MultiHop master radio or DX80 Gateway radio (star architecture) installed. Before
the ISM radio can communicate with DX80 Nodes, the DXM Controller must be bound to the other radios in the wireless
network. Use the DXM Controller LCD menu to bind radios to the internal DXM radio.

The LCD display and the processor applications share the external Modbus connection. If the processor is configured to

constantly interact with Modbus, it may cause issues with the LCD display attempting to use the functions of the ISM radio.
To alleviate the contention:
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= Load a DXM configuration file that slows down the read/write rules.

= Disable the DXM configuration file from loading into the processor by setting DIP switch 4 to ON (on the processor
board). Reboot the device. When the processor starts back up, it will not load the configuration file and remains
idle. See the DXM100 Controller Instructional Manual (190037) for the processor DIP switch location.

5.8 Entering Binding Mode
Under the ISM Radio menu, use the down arrow button to highlight the Binding menu. Click ENTER.

The ISM Radio menu is slightly different for the two different types of internal radio. The ISM Type displays '"MultiHop'
when the MultiHop radio board is installed and 'DX' when the DX80 star architecture radio board is installed.

Use the up/down arrows to enter the device number to bind to. When binding to devices with rotary dials, the device
number has no effect. To bind to devices without rotary dials, the device number is saved as the device Modbus slave ID in
the MultiHop network or the Node number in a DX80 network.

After entering binding mode on the DXM Controller, put the end device into binding mode to execute the binding process.
Most end devices enter binding by triple-clicking button 2 on the device. For specific instructions on entering binding for a
specific device, refer to the individual datasheet for that device.

To bind more devices, click the back button, change the device number (if needed), then enter binding again.

5.8 Conducting a Site Survey

Although the MultiHop and DX80 devices are architecturally different, the site survey process is similar when conducted
from the DXM LCD menu. From the ISM Radio menu, use the down arrow to highlight the Site Survey menu. Click
ENTER.

Use the Up or Down arrows to select the Node number (DX80 network) or Modbus Slave ID (MultiHop network). Click
ENTER to run the site survey with that Node or slave.

For a DX80 network, the Gateway controls the site survey and the results display on the LCD. Running Site Survey on a
DX80 network does not affect the throughput of the DX80 network.

For a MulitHop network, the master device passes the site survey request to the intended Modbus slave device. The Site
Survey runs and the results display on the LCD. Running Site Survey on a MultiHop network stops all network traffic to
that device.

5.9 Setting Up EtherNet/IP™

The DXM Controller is defined from the factory to send/receive register data from the Gateway and the first 16 Nodes with
an EtherNet/IP™4 host. To expand the number devices going to Ethernet/IP the user must change the Maximum Node
count parameter in the DX80 Gateway from 16 to 32. Use the DX80 Configuration Tool to set this parameter.

This allows the user to maximize the use of the EtherNet/IP buffer to 28 devices. To expand the number of devices further,
customize the data collection for EtherNet/IP using the DXM Configuration Tool and only selecting the needed registers. A
maximum of 228 registers can be read or written with Ethernet/IP.

EDS (Electronic Data Sheet) files allow users of the EtherNet/IP protocol to easily add a Banner DXM device. Download the
EDS files from the Banner website.

5.9 Configuring the Host PLC

On the host PLC, install the DXM Controller using an EDS file or by using the following parameters:
e Assemblyl: Originator to DXM = Instance 112, 456 bytes (228 words)
= Assembly2: DXM to Originator = Instance 100, 456 bytes (228 words)

The Originator is the host PLC system, and the DXM is the DXM Controller. The host system sees the DXM Controller as a
generic device with the product name of Banner DXM (ProdType: 43 - Generic Device, ProdName: Banner DXM).

5.9 Configuring the DXM Controller

Use the DXM Configuration Tool to define each local register to be Originator -> DXM or as a DXM -> Originator.

= Define a DXM local register as Originator -= DXM when the host PLC (Originator) will send data to the DXM
Controller local register (DXM).

4 EttherNet/IP is a trademark of Rockwell Automation.

38 www.bannerengineering.com - Tel: 763.544.3164



DXM100 Controller Instruction Manual

= Define a DXM local register as DXM -=> Originator when that register data will be sent from the DXM Controller
(DXM) to the host PLC (Originator).

Data from an EIP controller in assembly instance 112 is data destined for the DXM Controller local registers. The first two
bytes of the assembly instance are stored in the first local register defined as an Originator -> DXM register. The next
two bytes of the assembly instance are stored in the next local register defined as an Originator -=> DXM register. For
example, if DXM local registers 5, 12, 13, and 15 are configured as Originator -> DXM, the first eight bytes (four words)
of data from the assembly instance are stored into these registers in order (5, 12, 13, and 15). The system ignores the
rest of the bytes in the assembly instance.

Data from the DXM Controller local registers is sent to the EIP controller using assembly instance 100. Each local register
in the DXM Controller defined as DXM -> Originator is collected in numerical order and placed into the data buffer
destined for assembly instance 100. DXM local registers are capable of 32-bits, but only the lower 2-bytes for each local
register are transferred. For example, if DXM registers 1, 10, 20, and 21 are defined as DXM -> Originator registers, the
assembly instance 100 will have the first eight bytes of data coming from the DXM local registers 1, 10, 20, and 21. The
rest of the data is in assembly instance 100 is zero.

5.10 Setting up Email and Text Messaging

The DXM Controller can be configured to send email or SMS messages based on threshold conditions. Internal log files
may be sent using email

Cellular-connected systems can use email or SMS. Ethernet-connected systems may only use email, but can send email to
cellular phones as a SMS message depending upon the network carrier. To send email to a Verizon phone, use the phone
number followed by @vtext.com, for example, 1234567890@vtext.com.

Following these instructions using the DXM Configuration Tool to program the controller for email and/or SMS.

Set the time on the DXM Controller.

Define the Network Interface settings by selecting either Ethernet or Cell on the Cloud Services screen.

If you selected Ethernet, configure your Ethernet connection by setting the IP settings on the Network screen.
Set the email and message parameters on the Mail and Messaging screen.

To send alert messages, define the threshold rule to use email and/or SMS.

To send log files, define the log file parameters.

oahswnNpE

5.10 Define the Network Interface Settings

On the Cloud Services screen, define the network connection settings by selecting Ethernet or Cell from the Network
Interface drop-down list. This determines how the DXM Controller sends data. When selecting Ethernet, provide the
network parameters on the Network screen. If you don't require pushing data to a web server, set the Cloud Push
interval to zero.

Local Registers General JLelIGESIESWNWRE | ogging | Scrpting | Network | Mail and Messaging | Administration

s
Register Mapping (Ethernet | =] TR Server Name/IP: | push sensonix_net ‘
Pue [ |
Action Rules Cloud Push Interval: 0015 % HH:mm Host Header | ‘
Logging Interval: 00:00 = HH:mm

Site ID: | Clear| ©00000000-0000-0000-0000-000000000000

Scheduler ‘Webserver Authentication

[ Reguire Authentication

i

[] use HTTPS

Usemame Certificate CN:  *.sensonix.net

Register View

Password: 351 Port: 443

Send Authentication
Settings

5.10 Configuring your Ethernet Connection

To send email based on a threshold rule or to email log files, first define the network and email servers. In the DXM
Configuration Tool, go to Settings > Network.

1. To define the Ethernet IP address, give the DXM Controller a static IP address. In most cases you may select the
device to use DHCP and have the IP address automatically assigned.
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2. DNS settings are not typically required. The DXM Controller uses a public service to resolve Domain names, but if
the network connection does not have Internet access, the DNS settings may be required.

General | Cloud Services || Logging | Scripting |3 d Mail and Messaging | Administration

Local Registers

Current Device IP Cell VPN Firewall
_ . |P Address: 0.0.0.0 o
Reglsler Mapplng Cell Firewall IP Address: 0.0.0.0
Subnet: 0.0.0.0
e e 0.0.0.0 Cell Firewall Netmask: 255.2565.255.0
Action Rules Get Settings from Device
1 Enable SMS Control
IP Address
Scheduler S IP e
IP Address: 0.0.0.0
Register View
Subnet: 255255.255.0
Gateway Address: 0.0.0.0
Settings
DNS
Primary DNS |IP Address: 0.0.0.0
Secondary DMS |P Address: 0.0.0.0

5.10 Configuring your Cellular Connection

A cellular connection does not require any configuration other than being selected as the network connection under the
Cloud Services screen.

5.10 Setting the Email and Messaging Parameters

From the Settings > Mail and Messaging screen, enter the SMPT definition, login, and password for a mail server. You
must supply the SMTP Server, Server Port, and login credentials to send email. When only sending SMS messages over
cellular, the SMTP Server is not required. The default SMTP port is 25 but may need to be adjusted for Ethernet-based
networks. Note that many facilities block port 25. Port 587 is another common SMTP submission port.

The SMTP password is not stored in the XML configuration file, but on the DXM Controller. After the password is entered,

click on Send SMTP Password to send it to the DXM Controller. The password is stored in non-volatile memory, so reboot
the DXM Controller to recognize the new password.

Local Registers

Register Mapping

Action Rules

Scheduler

Register View

At the bottom of the screen, define the recipient to receive emails and enter the phone numbers for SMS messages. These

General

Cloud Services

Logging J| Scripting § Network JIETELLRNLEEELGBEE Administration

Mail Server Setfings

SMTP Server -
SMTP Server Port:

| smipmail visi.com | [x] Enable SMTP Authentication

587 ¥ User Name: |device@sensoni:-:.cum |

Password: | sxiemaill |

Send SMTP Password

Recipient(s):

Subject:

Message:

E-Mail Recipients
Expand All

+ | E-mail Recipient 1

Test message from DXM Controller ‘

Bution Pressed ‘

recipients for email or SMS messages can be selected in the threshold definition for sending alert messages.
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5.10 Defining Threshold Rules for Email

To define a threshold, go to Action Rules > Thresholds. Depending upon which recipients are defined, select the
appropriate email or SMS checkbox for the threshold rule (under Email/SMS on state transition). When the threshold
rules goes active or inactive, an email is generated.

. Thresholds | IR EEEeE Math / Logic § Trendin
Local Registers 4 A — Y

‘ ‘Add Threshold Rule ‘ | Delete Last Rule ‘

B New threshold rule When register 1 (None) Equals 32765 set register 2 (None) to 1 else 0

Action Rules When local register 1% Nonel= |~ |vawe |~ 32765

Register Mapping

then set local register number 2 % None to|Value - |1
Scheduler ——
else set the register to | Value >0
Register View E-mail'SMS on state transtion [l Logging Opfions
Hysteresis value: 0s Record the number of minutes E-mail SMS [ Save Threshold events to cloud
Minimum On time:  00-00:02 & that the rule has been true Recipient 1 [] ] (] save Threshold events to event og
Settings Minimum OF tme:  00:00:02 5 | | to register 0 = None | |Recpent2 [0 [1 | | []Push When Active
Recipient3 [] O After Trigger, Set destination to 0

5.10 Defining Log File Parameters for Emailing Log Files
The DXM Controller can email log files generated on the device.

Before emailing log files, set the Mail and Messaging parameters to provide the login credentials. When using Ethernet,
verify the IP address settings are defined on the Network screen. Set the DXM Controller time, under Settings >
General, so that all data is properly time stamped.

Select the registers to log on the Local Registers > Register Configuration screen. Define the setup of the log file
using the Settings > Logging screen. Typical settings are shown.
1. Enable the log and timestamp with every entry.

2. Enter the filename, log rate, and the maximum file size to send via email (5 to 10k is an efficient size for a cellular
connection).

3. Define the email address.

~ | Data Log 1

[¥] Enable Log
[¥] Enable timestamps on each log entry When full: LConlinue logging, discard oIdestJ vJ

File Name: | LogFile1 it Recipient(s): ‘myemall@sensnmx.com |

Log Rate; 00:00:30 %

Log file header style: | Text - Subject:
Max file size: 15 3 Kb

‘ DXM Log File |

Message:
Only log when Register o g ‘ |

named is greater then 0.

4. Define the local register data put into the log file using the Local Registers > Local Register Configuration
screen, under the Logging and Protocol Conversion section. From the SD Card Logging drop-down list, select
the log file to write to. Log files are written in CSV format.

5. Use the DXM Configuration Tool to read back the log files. Under Settings > Logging, click Refresh List,
highlight the file to download, then click Save Selected.

5.11 Ethernet and Cellular Push Retries

The DXM Controller can be configured to send register data packets to a webserver. When the Ethernet or cell
communications path is not operating, the DXM Controller retries the send procedure. The communications retry process is
outlined below for each configuration.

Regardless of the communications connection (Ethernet or cellular), a failed attempt results in the register data packet
being saved on the local micro SD card®. The number of retries will depend upon the network connection type.

www.bannerengineering.com - Tel: 763.544.3164 41



DXM100 Controller Instruction Manual

When there is bad cellular signal strength or there is no Ethernet connection, the transmission attempts are not counted as
failed attempts to send data. Only when there is a good network connection and there are 10 failed attempts will the
controller archive the data on the SD card. Data archived on the SD card must be manually retrieved.

5.11 Ethernet

With an Ethernet-based network connection, the DXM Controller retries a message five times. The five retry attempts
immediately follow each other. After all attempts are exhausted, the register data packet is saved on the micro SD card.

At the next scheduled time, the DXM Controller attempts to send the saved packet as well as the newly created register
data packet. If it cannot send the new register data packet, the new register data packet is appended to the saved file on
the micro SD card to be sent later. After 10 rounds of retries, the data set is archived on the micro SD card under folder
_sxi. No additional attempts to resend the data are made; the data file must be manually retrieved.

Using SSL on Ethernet will have no retries, but will save each failed attempt to the micro SD card until 10 failed rounds. At
this time, the register data packet is archived.

5.11 Cellular

In a cellular-connected system there are no retries. Failed transmissions are saved on the micro SD card.

After 10 successive failed attempts, the data is archived in the _sxi folder. Send attempts with a low signal quality are not
counted against the 10 count limit. For example, if the cellular antenna is disconnected for period that the DXM controller
would have sent 20 messages under normal circumstances, all 20 messages would be saved and will be retried when the

antenna is reconnected. If the signal quality was good, but the cellular network was not responding, the DXM Controller
archives the register data packets after 10 failed attempts.

5.11 Event/Action Rule or Log Files
Event-based pushes caused by Action rules and locally stored log files sent using email follow the same process when

failures occur, based on the network connection. The failed Event-based messages are resent with the next cyclical
schedule or the next event message that triggers a push message.

5.11 Email and SMS Messages

There are no retries for emails or SMS messages that fail to be sent from the DXM Controller.

5.12 Accessing the DXM Using SMS

The DXM Controller with a cellular modem can be remotely accessed using SMS messages. Simple text messages can:
= Force a push to the cloud
« Reboot the controller
= Read/write local registers

The incoming firewall provides security; only defined phone numbers are permitted to access the controller. Use the DXM
Configuration Tool to configure the SMS commanding feature. This feature requires firmware version 3.51 or later.

SMS command messages sent to the DXM Controller cause the DXM to respond if they come from approved phone
numbers. See the examples below for SMS responses. Responses may take 20 seconds or more, depending upon the
network.

A DXM Controller requires a few minutes after powering up before it can accept SMS messages. Initial cellular connection

times vary based on the wireless network. A SMS message sent to the controller while a push session is active delays any
response or the SMS message may be dropped based on the length of the push session.

5.12 HTTP Push

Push triggers a http push to a webserver. The DXM Controller accepts the message, executes the action, and sends an
acknowledgement text message back to the user.

Example: Texting push forces defined local registers to be sent to a webserver
push <send>

DXM Controller acknowledgement text message: Register push requested

5 Enable HTTP logging to save data on the SD card; this is the factory default. See SETTINGS -> LOGGING in the DXM Configuration
Tool.
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5.12 Reboot

Reboot triggers the DXM Controller to reboot. The processor reloads the XML configuration file and zeroes all local register
data. This does not affect the other components of the DXM Controller (ISM radio, 1/0 board, cellular modem). The DXM
Controller accepts the message, executes the action, and sends an acknowledgement text message back to the user.
Example: Texting reboot forces the processor to reboot.

reboot <send=

DXM Controller acknowledgement text message: rebooting..

5.12 Get Register

grN gets register number N (DXM Local Register) and sends a text with the value back to the user. The response text
message shows the value in floating point format regardless of register number.

Example: Texting grl retrieves the value for register 1
grl <send>

DXM Controller acknowledgement text message: Register 1 is 0

5.12 Set Register

srN, X sets a register value, where N is the register number and X is the value. The DXM Controller responds with a SMS
message indicating the register was set.

Example: Texting Srl,10 sets register 1 to value of 10
srl,10 <send>

DXM Controller acknowledgement text message: Register 1 has been set to 10

5.12 Configuring the DXM Controller for SMS Controlling

Configure the DXM Controller for SMS messaging capability using the DXM Configuration Tool.

1. On the Settings > Cloud Services screen, set the network interface to Cell.

2. On the Settings > Network screen, enter the phone numbers that are allowed access to the DXM Controller.

3. Save the configuration file (File > Save.

4. Load the XML file to the DXM Controller.

5. After the device has been running for a few minutes, the cellular network should be operational. The phone number
(MDN) is visible on the DXM LCD menu (System Info > Cell).

6. Send a text message to the DXM Controller from an approved phone number.

5.13 Using the Display LEDs

Turn on the DXM Controller LEDs by writing to the LEDs' Modbus registers.

The DXM display uses Modbus slave ID 201 and has four individual

registers for each of the four LEDs on the display. Display Modbus Display LED
Register
Turn on an LED by writing a 1 value to the register. Turn off the LED by 1102: bit 0 LED 1 (Green)
writing a O to the register.
1103: bit 0 LED 2 (Red)
Do not write to any other Modbus registers. They are used by the LCD 1104 bit 0 LED 3 (Yellow)

display for menu data.

1105: bit 0 LED 4 (Red)

DXM Controller Display Example

This example shows setting up the DXM Controller using the DXM Configuration Tool to read four universal inputs and
write the state values to the display LEDs.
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1. Using the DXM Configuration Tool, go to the Local Registers > Local Register Configuration screen.

2. Define the local registers by assigning names to the first four registers and setting the LCD permissions parameter
to read/write. The LCD permissions show the register contents on the LCD menu under the REGISTER menu. You
can also set the value from the LCD menu.

Local Registers Local Register Configuration | JUGLIRUTITERREE Y R IR E el L RIES

Register Mapping Display Information Constant Value and Counter Logging and Protocol Conversion

Units None ~ Constant |~ SD Card Logging: None -
Sign Type: unsigned hd - Protocol Conversion: None -
Scaling None - : =
LCD Permissions: |Neone =)
Scheduler Cloud

Action Rules

Cloud Reporting: Host Timeout Parameters

If the host fails to communicate with this register for

0 = seconds, set the registerto: 0

Register View : Display LEC2 Units
Display LEC3 Units

Settings Units- None:

3. Create a Read Rule to read the four universal inputs from the 1/0 board (Modbus slave 200) and write the values in
local registers 1 through 4.

Read Rules
Local Registers
Add Read Rule | | Delete Last Rule
Register Mapping Read I/0 Inputs Hmumg [ ECBRd from siave address ERRJReN starting at register mmugn mm local mgllitarmmmugn 4
Read Seflings Local Register Names
Action Rules Display LED1
Freguency: As fast as possible | = 000 & seconds Display LED2
Display LED3
Scaling: Scale value: 0 % Scale offset: [ Display LED4
Scheduler Error Condition: Apply value 0 % after 0 # read failures
Floating Point [ swap words

Register View

Settings

4. Create a Write Rule to write the four local register values to the DXM display registers 1102 through 1105 (Modbus
Slave 201). Define the Write Rule to only write the display registers when the inputs change.

RCELIITIERY | Write Rules

Add Write Rule | | Delete Last Rule
Register Mapping || &SN write Dispiay LEDS wiite local reg\slelmmunh {8 Holding Register | ~ [ETEESN] s(am'ng atregister RRLR through 1105
Local Registers Names

Frequency: Display LED1

Local Registers

Action Rules

PS Display LED2
Write when register changes by: 0 % Deniey (03
Write at LEAST Every: 0.0 % seconds Display LED4

Scheduler

Write at MOST every. 0.00 * seconds
Scaling Scale Value: 0.000000 ¢ Scale Offset: 0 *

Register View Floating Point [ swap words

Settings

5. Save the XML configuration from the File > Save As menu.
Connect to the DXM Controller using a USB cable and select Device > Connection Settings from the menu bar.

7. Upload the XML configuration file to the DXM Controller by selecting Device > Upload Configuration to Device
from the menu bar.

2

After a configuration file is uploaded, the DXM Controller reboots. The new configuration is now running.

Turning on any one of the universal inputs 1 through 4 on the 1/0 base board of the DXM Controller now turns on an LED
on the display.

On the DXM Controller's LCD menu, the arrow on the left side of the register line indicates this local register can be written

to. Try changing the configuration to delete the Read Rule then turn on/off the LEDs by changing the register value
through the LCD display.
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6 File System and Archive Process

The DXM file system consists of two physical components: the serial EEPROM that stores non-volatile configuration
information and a removable micro SD card that stores file backup data and user created files.

6 EEPROM Files

The serial EEPROM stores basic data that is required to be non-volatile, including network configuration data, IP address,
MAC address, network masks, firewall settings, and authentication information. The controller XML configuration file
created by the DXM Configuration Tool is stored in EEPROM. The small section of non-volatile local registers is also stored
in EEPROM.

6 Micro SD Card Files

The micro SD card contains most files at the root level. The archive directory contains files kept by the system for history
backup. Archive files are stored in the directory _sxi and are only accessible by removing the SD card.

= Data Log Files

e HTTP Push Files

= User created ScriptBasic file

= ScriptBasic program file

= CmVMon file

* _sxi Archive directory

Archive Only two types of files are moved into the archive directory: data log files and HTTP log files. Data log

Directory files are date/time stamped and placed into the archive directory when the size limit is reached. HTTP
log files are date/time stamped then placed into the archive directory when they are successfully sent
to the webserver or host system. If the HTTP log files were not successfully sent after the retries have
been exhausted, the files are placed into a root directory called sav.

Data Log files Users may create up to four data log files using the DXM Configuration Tool. The log files are stored in
the root directory on the SD card. When the file size limit is reached, the filename is changed to include
the date and time and the file is moved into the archive directory _sxi. If a finished log file is to be e-
mailed, it will be done at this time and then moved into the archive directory. Archived log files are
deleted based on the Clear Logs parameter.

HTTP Push If the DXM Controller is configured to send data to a webserver or host system, the device creates an

File HTTP.LOG file on the SD card. The HTTP log is created only if the Logging Interval is non-zero and the
HTTP enable log is set. An entry is placed in the HTTP log file at the Logging Interval specified by the
user. At the Push Interval time, the HTTP log file is sent to the webserver or host system. If the
transmission is successful, the HTTP log file is time stamped and placed into the archive directory
(_sxi). If the transmission fails, the file remains in the root directory and subsequent Logging Intervals
are appended to the file and are sent at the next Push Interval. For more information on the
communications retry mechanism, refer to the technicel note on system retries. (DXM Ethernet and
Cellular Push Retries.docx).

ScriptBasic Users may use ScriptBasic to create files on the SD card by using the FILEOUT function. The filenames
Created Files are fixed and up to five files can be created in the root directory.

ScriptBasic The main ScriptBasic program that runs at boot time is stored on the SD card in the root directory.
Program File

System The CmVMon.txt file (Cellular milli-Volt Monitor) is created by the system and is used to track power
Voltage events. Every power-up cycle is date/time stamped with the voltage read from the 1/0 board. The

Monitor File value 24487 is equal to 24.487 volts. If the voltage drops below 11.2 V, another entry is put in the log
file indicating the cellular modem will shut down.

CM 2015-09-22 18:52:43 VMon Power entered normal range 24487
CM 2015-10-13 20:49:47 VMon Power entered normal range 24004
CM 2015-10-16 15:00:20 VMon Power entered normal range 24014
CcM 2015-10-19 19:12:26 VMon Power entered normal range 12845
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7 DXM Modbus Registers

The DXM100 Controller may have up to four internal Modbus slave devices:

DXM Internal Modbus Slave IDs (factory default)

Modbus Slave ID Device
1 Gateway (PE5) or MultiHop (HE5) ISM Radio—MultiHop wireless devices connected to the internal MultiHop radio should
be assigned Modbus Slave addresses starting at 11.
199 Local Registers—Internal storage registers of the DXM Controller
200 1/0 Base Board—All data and parameters for each input or output of the DXM Controller.
201 LCD Display—The user has access to the LED indicators on the DXM Controller.

All Modbus registers are defined as 16-bit Modbus Holding Registers. When connecting external Modbus slave devices, only
use Modbus slave IDs 2 through 198. The local registers, the 1/0 base, and the LCD slave IDs are fixed, but the internal
radio slave ID can be changed if needed.

7.1 Gateway Performance 1 Watt Radio

The DX80 Gateway (PE5) is a star-based architecture device that contains all the Modbus registers for the wireless
network within the Gateway. To access any input or output values within the entire wireless network, read the appropriate
Modbus register from Gateway.

There are 16 Modbus registers allocated for each device in the wireless network. The first 16 registers (1-16) are allocated
for the Gateway, the next 16 (17—32) are allocated for Node 1, the next 16 (33—48) are allocated for Node 2 and so forth.
There are no inputs or outputs on the DXM embedded Gateway but the Modbus registers are still allocated for them.
Although only seven Nodes are listed in the table, the Modbus register numbering continues for as many Nodes as are in

the network. For example, the register number for Node 10, 1/0 point 15 , is 175. Calculate the Modbus register number
for each device using the equation:

Register Number = 1/0# + (Node# x 16)

Table 1: Modbus Holding Registers

170 Point Gateway Node 1 Node 2 Node 3 Node 4 Node 5 Node 6 Node 7
1 1 17 33 49 65 81 97 113
2 2 18 34 50 66 82 98 114
3 3 19 35 51 67 83 99 115
4 4 20 36 52 68 84 100 116
5 5 21 37 53 69 85 101 117
6 6 22 38 54 70 86 102 118
7 7 23 39 55 71 87 103 119
8 8 24 40 56 72 88 104 120
9 9 25 41 57 73 89 105 121
10 10 26 42 58 74 90 106 122
11 11 27 43 59 75 91 107 123
12 12 28 44 60 76 92 108 124
13 13 29 45 61 77 93 109 125
14 14 30 46 62 78 94 110 126
15 15 31 47 63 79 95 111 127
16 16 32 48 64 80 96 112 128

Example: DX80 Performance Gateway Modbus Register Table
Access all wireless network registers by reading Modbus slave ID 1.
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DX80 Device Slave ID Modbus Registers

DXM Gateway radio 1 Modbus registers 1-8 are inputs, 9—16 are outputs
Node 1 - Modbus registers 17—25 are inputs, 26—32 are outputs
Node 2 - Modbus registers 33—40 are inputs, 41-48 are outputs
Node 3 - Modbus registers 49-56 are inputs, 57—64 are outputs

7.1.1 Alternative Modbus Register Organization

The Sure Cross DX80 Alternative Modbus Register Organization registers are used for reordering data registers to allow
host systems to efficiently access all inputs or outputs using a single Modbus command. The register groups include the
input/output registers, bit-packed registers, and analog registers. This feature is only available with the Performance
models using version 3 or newer of the LCD firmware code.

Name Modbus Register Address (Dec.)
Inputs and Outputs, in order by device 2201 through 4784
Discrete Bit Packed (Status, Discrete Inputs, Discrete Outputs) 6601 through 6753
Analog Inputs (1-8) and Analog Outputs (1-8) 6801 through 9098

Modbus registers 2201 through 2584 are used to organize all inputs together. In this format, users can sequentially read
all input registers using one Modbus message. Modbus registers 4401 through 4784 organize all outputs together to allow
users to sequentially write to all outputs registers using one Modbus message.

Inputs (2201-2584) Outputs (4401—-4784)

Modbus Register Address (Dec) 16-bit Register Value Modbus Register Address (Dec) 16-bit Register Value
2201-2208 Gateway Inputs 1 through 8 4401-4408 Gateway Outputs 1 through 8
2209-2216 Node 1 Inputs 1 through 8 4409-4416 Node 1 Outputs 1 through 8
2217-2224 Node 2 Inputs 1 through 8 4417-4424 Node 2 Outputs 1 through 8
2577-2584 Node 47 Inputs 1 through 8 4777-4784 Node 47 Outputs 1 through 8

Refer to your device's datasheet for a list of the active inputs and outputs. Not all inputs or outputs listed in this table may
be active for your system.

Discrete bit-packed registers include the discrete status registers, discrete inputs, and discrete outputs.
Bit packing involves using a single register, or range of contiguous registers, to represent 1/0 values.

When networks use similar Nodes to gather data using the same 1/0 registers for each Node, discrete data from multiple
Nodes can be bit packed into a single register on the Gateway. The bit-packed data is arranged by 1/0 point starting at
Modbus register 6601. For example, Discrete IN 1 for all the Nodes in the network is stored in three contiguous 16-bit
registers.

The most efficient way to read (or write) discrete data from a SureCross® DX80 Gateway is by using these bit-packed
registers because users can read or write registers for all devices using one Modbus message. The following registers
contain discrete bit-packed 1/0 values for the Gateway and all Nodes. Values are stored first for the Gateway, then for
each Node in order of Node address.
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Bit-Packed Device Status Registers

Bit Position
Register Address 15 14 13 12 1 10 9 8 7 6 b} 4 Bl 2 1 0
6601 Node 15 | Node 14 ' Node 13 | Node 12 | Node 11 | Node 10 | Node9 | Node8 = Node7 | Node6 | Node5 = Node4 | Node3 | Node2 | Node1 @ Gateway
6602 Node 31 | Node 30 | Node 29 ' Node 28 ' Node 27 | Node 26 | Node 25 ' Node 24 = Node 23 | Node 22 | Node 21 ' Node 20 | Node 19 | Node 18 | Node 17 | Node 16
6603 Node 47 | Node 46 | Node 45 ' Node 44 ' Node 43 | Node 42 | Node 41  Node40 | Node 39 | Node 38 | Node 37 = Node 36 = Node 35 | Node 34 | Node 33 | Node 32
Bit-Packed Discrete Input 1
Bit Position
Register Address 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
6611 Node 15 | Node 14 ' Node 13 | Node 12 | Node 11 | Node 10 | Node9 | Node8 ' Node7 | Node6 | Node5 = Node4 | Node3 | Node2 | Node1 @ Gateway
6612 Node 31 | Node 30 | Node 29 | Node 28 | Node 27 | Node 26 | Node 25 ' Node 24 | Node 23 | Node 22 | Node 21 ' Node 20 = Node 19 | Node 18 | Node 17 | Node 16
6613 Node 47 | Node 46 | Node 45 ' Node 44 | Node 43 | Node 42 | Node 41 ' Node40 | Node 39 | Node 38 | Node 37 = Node 36 = Node 35 | Node 34 | Node 33 | Node 32
Bit-Packed Discrete Output 1
Bit Position
Register Address 15 14 13 12 1 10 9 8 7 6 5 4 3 2 1 0
6691 Node 15 | Node 14 | Node 13 ' Node 12 | Node 11 | Node 10 | Node9 | Node8 | Node7 | Node6 | Node5 | Node4 = Node3 | Node2 | Node1 | Gateway
6692 Node 31 | Node 30 | Node 29 | Node 28 ' Node 27 | Node 26 | Node 25 = Node 24 = Node 23 | Node 22 | Node 21 | Node 20 | Node 19 | Node 18 = Node 17 | Node 16
6693 Node 47  Node 46 | Node 45 = Node44 ' Node43 | Node42 Node41 Node40 | Node39 | Node38 Node37  Node36 Node35 | Node34 Node33 = Node 32
Inputs Outputs
Modbus Register Description (Inputs) Modbus Register Description (Outputs)
Address (Decimal) Address (Decimal)
6601-6603 Status for all devices
6611-6613 Input 1 from all devices 6691-6693 Output 1 from all devices
6621-6623 Input 2 from all devices 6701-6703 Output 2 from all devices
6631-6633 Input 3 from all devices 6711-6713 Output 3 from all devices
6641-6643 Input 4 from all devices 6721-6723 Output 4 from all devices
6651-6653 Input 5 from all devices 6731-6733 Output 5 from all devices
6661-6663 Input 6 from all devices 6741-6743 Output 6 from all devices
6671-6673 Input 7 from all devices 6751-6753 Output 7 from all devices
6681-6683 Input 8 from all devices

Status registers (6601-6603) contain a bit-packed representation defining the devices that are operational in the
wireless system.

Input registers from all devices use Modbus registers 6611 through 6683 to organize the least significant bit into a
sequential array of registers. The first register contains the least significant bit from the input values for the Gateway
through Node 15. The second register contains the input values for Node 16 through Node 31, and the third register

contains the input values for Nodes 32 through 47.

For discrete inputs, only the least significant bit is used. For analog inputs, the least significant bit indicates if the analog
value is above or below the selected threshold value (when using the threshold parameter). For example, a least
significant bit of one (1) indicates the analog value is above the selected threshold value. A least significant bit of zero (0)
indicates the analog value is below the threshold value.

Output registers from all devices use Modbus registers 6691 through 6753 to organize the least significant bit into a
sequential array of registers. Output 8 (1/0 point 16) cannot be written using the discrete format.

The most efficient way to read (or write) analog data from a Gateway is by using these 16-bit analog registers. Most
networks consist of similar Nodes reporting data using the same 1/0 registers for each Node. For this reason, the analog
data is arranged by 1/0 point using Modbus registers 6801 through 9098. For example, Input 1 for Gateway and all Nodes
is stored in the first 48 contiguous blocks of 16-bit analog registers, beginning with register 6801.

In this format, users can read a 16-bit holding register for all devices or write to a register for all devices using one
Modbus message. Using these registers is the most efficient way to read all status registers, read all analog inputs, or
write all analog outputs.

The following registers contain analog 1/0 values for the Gateway and all Nodes. Values are stored first for the Gateway,
then for each Node in order of Node address.
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Inputs Outputs
Modbus Register Address Description (Inputs) Modbus Register Description (Outputs)
(Decimal) Address (Decimal)
6801 Input 1 for Gateway 8001 Output 1 for Gateway
6802 Input 1 for Node 1 8002 Output 1 for Node 1
6803 Input 1 for Node 2 8003 Output 1 for Node 2
6951 Input 2 for Gateway 8151 Output 2 for Gateway
6952 Input 2 for Node 1 8152 Output 2 for Node 1
6953 Input 2 for Node 2 8153 Output 2 for Node 2
7101 Input 3 for Gateway 8301 Output 3 for Gateway
7102 Input 3 for Node 1 8302 Output 3 for Node 1
7103 Input 3 for Node 2 8303 Output 3 for Node 2
7851 Input 8 (Status Register) for Gateway 9051 Output 8 for Gateway
7852 Input 8 (Status Register) for Node 1 9052 Output 8 for Node 1
7853 Input 8 (Status Register) for Node 2 9053 Output 8 for Node 2

For example, 6801 contains the input 1 value for the Gateway, 6802 contains the input 1 value for Node 1, and 6848
contains the input 1 value for Node 47.

7.2 MultiHop 1 Watt Radio

The DX80 MultiHop master radio (HE5) is a tree-based architecture device that allows for repeater radios to extend the
wireless network. Each device in a MultiHop network is a Modbus device with a unique Modbus ID. Modbus registers in a
MultiHop network are contained within each individual radio device. To get Modbus register data from a MultiHop device,
configure the DXM Controller to access each device across the wireless network as an individual Modbus slave device.

Example: MultiHop Modbus Register Table
Example MultiHop Modbus registers with generic devices.

MulitHop Device Slave ID Modbus Registers

DXM Master radio 1 none

Slave device 11 Modbus register 1-16 are inputs, 501-516 are outputs
Repeater device 12 Modbus register 1-16 are inputs, 501-516 are outputs
Slave device 15 Modbus register 1-16 are inputs, 501-516 are outputs

7.3 Modbus Registers - Internal Local Registers (Modbus Slave 199)

The main storage elements for the DXM Controller are its Local Registers, which can store 4-byte values that result from
register mapping, action rules, or ScriptBasic commands.

Local Registers 1 through 850 are standard 32-bit signed registers.
Local Registers 851 through 900 are non-volatile registers that are limited to 100,000 write cycles.

Local Registers 1001 through 1900 are floating point format numbers. Each register address stores half of a
floating point number. For example, registers 1001 and 1002 store the first full 32-bit floating point number.

Local Registers 10001 through 19000 are system, read-only, registers that track DXM Controller data and
statistics.
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7.3 Local Registers 1-850 (Internal Processor Memory, 32-bit, Unsigned)

The local registers are the main global pool of registers. Local registers are used as basic storage registers and as the
common data exchange mechanism.

Modbus slave ID O is reserved for the processor.

External Modbus device registers can be read into the local registers or written from the local registers. The DXM
Controller, as a Modbus master device or a Modbus slave device, exchanges data using the local registers.

Modbus over Ethernet (Modbus/TCP) uses the local registers as the accessible register data.

7.3 Local Registers 851-900 (Data Flash, Non-volatile, 32-bit, Unsigned)

The top 50 local registers are special non-volatile registers. The registers can store constants or calibration type data that
must be maintained when power is turned off.

This register data is stored in a data flash component that has a limited write capability of 100,000 cycles, so these
registers should not be used as common memory registers that change frequently.

7.3 Local Registers 1001-1900 (32-bit IEEE Floating Point)

These local registers are paired together to store a 32-bit IEEE floating point format number in big endian format.

Registers 1001 [31:16], 1002 [15:0] store the first floating point value; registers 1003, 1004 store the second floating
point number. There are a total of 500 floating point values; they are addressed as two 16-bit pieces to accommodate the

Modbus protocol.

Use these registers when reading/writing external devices that require Modbus registers in floating point format. Since
Modbus transactions are 16-bits, the protocol requires two registers to form a 32-bit floating point number.

7.3 Virtual Registers

The DXM Controller has a small pool of virtual registers that show internal variables of the main processor. Some register
values will be dependent upon the configuration settings of the DXM Controller.

10011-10012

10013-10014

10015-10016

10017-10018

10021

10022

10023

10024

10025-10026

10027-10028

10029-10030

10031-10032

10033-10034

10035-10036

10037-10038

50

Resync timer

Resync timer rollover

Reboot cause (Restart Codes above)
Watchdog reset count

10 Board Battery Voltage (mV)

10 Board Battery Charging Current (mA)
10 Board Incoming Supply (mV)

10 Board On board thermistor ( degrees C)
Http Push SSL Acquires

Http Push SSL Releases

Http Push SSL Forced Releases

Http Push Attempts

Http Push Successes

Http Push Failures

Http Push Last Status

Registers Definition

10001 GPS latitude direction (N, S, E, W) GPS Coordinate Data if the DXM is configured to read an external GPS unit.
10002 GPS latitude

10003 GPS longitude direction (N, S, E, W)

10004 GPS longitude

Engineering use

Engineering use

Reboot Type

Counter to track how many resets have been caused by the Watchdog

DXM Base 1/0 board battery / solar charger statistics.

Refer to the DXM Instruction Manual for more information.

Statistical counts of connections, disconnections and forced disconnects when
the DXM Controller creates a connection using SSL/TLS (Encrypted
connections)

Statistical counts of connections, disconnections and forced disconnects when
the DXM controller creates a connection using HTTP non-encrypted

Last DXM Controller push status
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Registers Definition

10039-10040 Cellular Strength, BER Cellular signal strength. Value range: 0-31
0 =-113 dBm or less
1=-111 dBm
2-30 = —109 dBm through —53 dBm in 2 dBm steps
31 = -51 dBm or greater
99 = not known or not detectable; BER not used

10100 Number of read maps in default Read Map statistics

10101 Number of read map successes

10102 Number of read map timeouts

10103 Number of read map errors

10104 Read map success streak

10105 Number of write map successes Write Map statistics

10106 Number of write map timeouts

10107 Number of write map errors

10108 Write map success streak

10109 Number of passthrough successes APl message passing statistics

10110 Number of passthrough timeouts

10111 Number of passthrough errors

10112 Passthrough success streak

10113 Number of 43 buffer successes DX80 Gateway automatic messaging buffer statistics

10114 Number of 43 buffer timeouts

10115 Number of 43 buffer errors

10116 43 buffer success streak

11000 Read map success count Read/Write maps statistics

12000 Write map success count

13000 Read map timeout count

14000 Write map timeout count

15000 Read map error count

16000 Write map error count

17000 Read map success streak

18000 Write map success streak

19000 Read map is in default

7.3 Reset Codes

The reset codes are in virtual register 11015 and define the condition of the last restart operation.

Code Definition
0 Undefined
1 Unknown
2 General
3 Brownout
4 Watchdog
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Code Definition
5 User
6 Software
7 Return from backup mode

7.4 1/0 Base Board (Modbus Slave 200)

The 1/0 base board stores the input and output values in Modbus holding registers. Since the 1/0 base board is defined as
a separate device, configure the DXM Controller to read or write the values on the 1/0 base board.

Base Board Input Connection

Modbus Register Range Description
1 0-65535 Universal input 1
2 0-65535 Universal input 2
3 0-65535 Universal input 3
4 0-65535 Universal input 4

Universal Input Register Ranges

Register Types Unit Minimum Value Maximum Value
Discrete input/output 0 1
Universal input O to 10 V mv 0 10000 6
Universal input O to 20 mA PA 0 20000 6
Universal input temperature (—40 °C to +85 °C) C or F, signed, in tenths of a degree —400 850
Universal potentiometer unsigned (o] 65535

Base Board Output Connection

Modbus Register Range Description

501 0-1 NMOS Output 1

502 0-1 NMOS Output 2

503 0-1 NMOS Output 3

504 0-1 NMOS Output 4

505 0-1 Switched Power 1 (5 V or 16 V)

506 0-1 Switched Power 2 (5 V or 16 V)

507 0-20000 Analog Output 1 default (0-20.000 mA)
0-10000 Analog Output 1 (0-10.000 V)

508 0-20000 Analog Output 2 default (0-20.000 mA)
0-10000 Analog Output 2 (0-10.000 V)

7.4 Input/Output Configuration Registers

Each input or output on the 1/0 base board has associated Modbus registers that configure its operation.

Universal Input Parameters Registers

Universal Inputs 1 2 3 4

Enable Full Scale Registers 3303 3323 3343 3363

6 Setting Enable Full Scale to 1 sets the ranges to a linear scale of O to 65535.
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Universal Input Parameters Registers

Universal Inputs 1 2 3 4

Temperature °C/°F Registers 3304 3324 3344 3364
Input Type Registers 3306 3326 3346 3366
Threshold Registers 3308 3328 3348 3368
Hysteresis Registers 3309 3329 3349 3369
Enable Rising Registers 4908 4928 4948 4968
Enable Falling Registers 4909 4929 4949 4969
High Register for Counter Registers 4910 4930 4950 4970
Low Register for Counter Registers 4911 4931 4951 4971

Enable Full
Scale.

Enable Rising/
Falling

High/Low
Register for
Counter

Hysteresis and
Threshold.

Input Type

Temperature
°C/°F

Set to 1 to enable a linear range from 0 to 65535 for specified input range. For a 4 to 20 mA input, a
value of O represents 4 mA and 65535 represents 20 mA. Set this parameter to O to store input
readings in unit-specific data. For example, the register data representing a 15.53 mA reading is
15530. For units of current (0 to 20 mA inputs), values are stored as pA (micro Amps) and voltage
values are stored as mV (millivolts).

Use these registers to enable the universal input logic to count on a rising transition or a falling
transition. Write a one (1) to enable; write a zero (0) to disable.

The low and high registers for the counter hold the 32-bit counter value. To erase the counter, write
zeroes to both registers. To preset a counter value, write that value to the appropriate register.

Threshold and hysteresis work together to establish the ON and OFF points of an analog input. The
threshold defines a trigger point or reporting threshold (ON point) for a sensor input. Setting a
threshold establishes an ON point. Hysteresis defines how far below the threshold the analog input is
required to be before the input is considered OFF. A typical hysteresis value is 10% to 20% of the
unit’s range.

In the example shown graphically, the input is considered

on at 15 mA. To consider the input off at 13 mA, set the
Threshold hysteresis to 2 mA. The input will be considered off when
. the value is 2 mA less than the threshold.

ON point

Input Value
|

Time

Program the universal inputs to accept input types NPN, PNP, 10k thermistor, O to 10 V, O to 20 mA,
or potentiometer. The default setting is 8: NPN raw fast. To set the input type, write the following
values to the Input Type Modbus registers.

0 = NPN

1 =PNP

2=0to 20 mA

3=0to10Vdc

4 = 10k Thermistor

5 = Potentiometer Sense (DXM150 only)

6 = Not used

7 = Bridge

8 = NPN Raw Fast (default)

Set to 1 to represent temperature units in degrees Fahrenheit, and set to O (default) to represent
temperature units in degrees Celsius.
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7.4 Analog Output Configuration Registers
The 1/0 base board has two analog outputs that are selectable as 0 to 20 mA (factory default) or O to 10 V.

To change the analog output characteristic, physical jumpers must be change on the 1/0 board and a parameter Modbus
register must be changed. For step by step instructions on changing the output characteristics see section 5.2.3 Analog
(DAC) Outputs

Modbus Register Analog Output Description
4008 Analog Output 1 0 to 20 mA or O to 10 V dc output (1/0 board jumper selectable)
4028 Analog Output 2 Accuracy: 0.1% of full scale +0.01% per °C

Resolution: 12-bit
After changing the jumper position, write the appropriate value to the Modbus registers to define
your analog output to match the setting selected by the jumper.

2 = 0 to 20 mA output (default)
3 =0 to 10 V output

7.4 Power Configuration Registers

To monitor the input power characteristics of the DXM Controller, read the following power Modbus registers. The on-board
thermistor is not calibrated, but can be used as a non-precision temperature input.

Modbus Register Description

6071 Battery backup charging algorithm.

0 = Battery is recharged from a solar panel
1 = Battery is recharged from 12 to 30 V dc . (default)

6081 Battery voltage (mV)

6082 Battery charging current (mA)

6083 Incoming supply voltage (mV) (solar or power supply)
6084 On-board thermistor temperature (°C)

7.5 LCD Board (Modbus Slave 1D 201)

Control the four user-defined LEDs using the display board's Modbus registers. Using write maps or ScriptBasic, write the
Modbus registers shown below with 0 (off) or 1 (on). The LCD display is Modbus Slave 201.

Modbus Register 1/0 Connection Modbus Register 1/0 Connection
1102 : bit O LED 1 1104 : bit O LED 3
1103 : bit O LED 2 1105 : bit O LED 4
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8 Restoring Factory Default Settings

To reset to factory defaults, write to two Modbus registers in the 1/0 board. The default slave ID for the 1/0 board is 200.

To reset the DXM 1/0 board parameters:

1. Write a 1 to Modbus register 4152
2. Write a 10 to Modbus register 4151

To reset only the 1/0 board:

1. Write a O to Modbus register 4152
2. Write a 10 to Modbus register 4151

Modbus Register Values Description

4151 0-255 Reset/restore trigger. This timer is based in 100 millisecond units. Once written, the timer starts to count down to
zero. After the timer expires, the restore factory defaults are applied if register 4152 = 1. If register 4152 is zero,
the 1/0 board is reset.

Default value: O

1 = 100 milliseconds, 10 = 1 second.

4152 0-1 1 = Restores factory defaults for 1/0 parameters.

Default value: O
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9 Contact Us

Corporate Headquarters

Address:

Banner Engineering Corporate
9714 Tenth Avenue North
Minneapolis, Minnesota 55441, USA

Europe

Phone: +1 763 544 3164
Website: www.bannerengineering.com

Address:

Banner Engineering EMEA
Park Lane Culliganlaan 2F
Diegem B-1831, Belgium

Turkey

Phone: +32 (0)2 456 0780
Website: www.bannerengineering.com/eu
Email: mail@bannerengineering.com

Address:

Banner Engineering Turkey

Barbaros Mah. Uphill Court Towers A Blok D:49
34746 Bati Atasehir Istanbul Turkiye

India

Phone: +90 216 688 8282
Website: www.bannerengineering.com.tr
Email: turkey@bannerengineering.com.tr

Address:
Banner Engineering India Pune Head Quarters

Office No. 1001, 10th Floor Sai Capital, Opp. ICC Senapati Bapat Road

Pune 411016, India

Mexico

Phone: +91 (0) 206 640 5624
Website: www.bannerengineering.co.in
Email: salesindia@bannerengineering.com

Address:
Banner Engineering de Mexico Monterrey Head Office

Edificio VAO Av. David Alfaro Siqueiros No.103 Col. Valle Oriente C.P.66269

San Pedro Garza Garcia, Nuevo Leon, Mexico

Brazil

Phone: +52 81 8363 2714 or 01 800 BANNERE (toll free)
Website: www.bannerengineering.com.mx
Email: mexico@bannerengineering.com

Address:

Banner do Brasil

Rua Bardo de Teffé n® 1000, sala 54

Campos Eliseos, Jundiai - SP, CEP.: 13208-761, Brasil

China

Phone: +1 763 544 3164
Website: www.bannerengineering.com.br
Email: brasil@bannerengineering.com

Address:

Banner Engineering Shanghai Rep Office

Xinlian Scientific Research Building Level 12, Building 2
1535 Hongmei Road, Shanghai 200233, China

Japan

Phone: +86 212 422 6888
Website: www.bannerengineering.com.cn
Email: sensors@bannerengineering.com.cn

Address:

Banner Engineering Japan

Cent-Urban Building 305 3-23-15 Nishi-Nakajima Yodogawa-Ku
Osaka 532-0011, Japan

Taiwan

Phone: +81 (0)6 6309 0411
Website: www.bannerengineering.co.jp
Email: mail@bannerengineering.co.jp

Address:

Banner Engineering Taiwan

8F-2, No. 308 Section 1, Neihu Road
Taipei 114, Taiwan

Phone: +886 (0)2 8751 9966
Website: www.bannerengineering.com.tw
Email: info@bannerengineering.com.tw

56 www.bannerengineering.com - Tel: 763.544.3164



DXM100 Controller Instruction Manual

10 Warnings

Install and properly ground a qualified surge suppressor when installing a remote antenna system. Remote antenna configurations installed without surge
suppressors invalidate the manufacturer's warranty. Keep the ground wire as short as possible and make all ground connections to a single-point ground system to ensure no
ground loops are created. No surge suppressor can absorb all lightning strikes; do not touch the Sure Cross® device or any equipment connected to the Sure Cross device
during a thunderstorm.

Exporting Sure Cross® Radios. It is our intent to fully comply with all national and regional regulations regarding radio frequency emissions. Customers who want to
re-export this product to a country other than that to which it was sold must ensure the device is approved in the destination country. A list of approved
countries appears in the Radio Certifications section of the product manual. The Sure Cross wireless products were certified for use in these countries using the antenna that
ships with the product. When using other antennas, verify you are not exceeding the transmit power levels allowed by local governing agencies. Consult with Banner
Engineering Corp. if the destination country is not on this list.

Any misuse, abuse, or improper application or installation of this product or use of the product for personal protection applications when the product is identified as not
intended for such purposes will void the product warranty. Any modifications to this product without prior express approval by Banner Engineering Corp will void the product
warranties. All specifications published in this document are subject to change; Banner reserves the right to modify product specifications or update documentation at any
time. For the most recent version of any documentation, refer to: www.bannerengineering.com. © Banner Engineering Corp. All rights reserved.

10.1 Banner Engineering Corp. Limited Warranty

Banner Engineering Corp. warrants its products to be free from defects in material and workmanship for one year following the date of shipment. Banner Engineering Corp.
will repair or replace, free of charge, any product of its manufacture which, at the time it is returned to the factory, is found to have been defective during the warranty
period. This warranty does not cover damage or liability for misuse, abuse, or the improper application or installation of the Banner product.

THIS LIMITED WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION,
ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE), AND WHETHER ARISING UNDER COURSE OF PERFORMANCE, COURSE
OF DEALING OR TRADE USAGE.

This Warranty is exclusive and limited to repair or, at the discretion of Banner Engineering Corp., replacement. IN NO EVENT SHALL BANNER ENGINEERING CORP. BE
LIABLE TO BUYER OR ANY OTHER PERSON OR ENTITY FOR ANY EXTRA COSTS, EXPENSES, LOSSES, LOSS OF PROFITS, OR ANY INCIDENTAL,
CONSEQUENTIAL OR SPECIAL DAMAGES RESULTING FROM ANY PRODUCT DEFECT OR FROM THE USE OR INABILITY TO USE THE PRODUCT, WHETHER
ARISING IN CONTRACT OR WARRANTY, STATUTE, TORT, STRICT LIABILITY, NEGLIGENCE, OR OTHERWISE.

Banner Engineering Corp. reserves the right to change, modify or improve the design of the product without assuming any obligations or liabilities relating to any product
previously manufactured by Banner Engineering Corp.
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